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Publication information
Edition notice

This publication is intended for engineers and other personnel using EVIDAS 
to perform measurement tasks.

Every effort has been made to ensure that all the information contained in this 
publication is correct at the time of publishing. However, the manufacturer 
may need to update the information as a result of product surveillance and 
development activities, leading to a new version of this publication.

Training and Support

For training and support contact the local HBM representative or the 
manufacturer (Manufacturer, 4).

Copyright

© 2019, Hottinger Baldwin Messtechnik GmbH, Darmstadt, Germany.

All rights reserved.

No part of this document may be reproduced without written permission from 
Hottinger Baldwin Messtechnik GmbH.

Trademarks

EVIDAS is a registered trademark of Hottinger Baldwin Messtechnik GmbH.

The EVIDAS logo is a trademark of Hottinger Baldwin Messtechnik GmbH.

All other trademarks are the property of their respective owners.

Feedback

Every effort has been made to ensure that this publication fulfills the intended 
purpose. All feedback on any aspect of this publication is welcome and is 
considered during updates. Should you have any such feedback, contact the 
local HBM representative or the manufacturer (Manufacturer, 4).
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1 Quick Start Guide
1.1 Installing EVIDAS

Prerequisites

 Internet connection.

To install EVIDAS

1 Download EVIDAS from the HBM website.
 If you want to install EVIDAS on an offline computer, copy the setup file 
to the offline computer.

2 Double-click the setup file, follow the instructions, and select Create a 
desktop icon.
 EVIDAS is installed and the EVIDAS icon  is displayed on the 
Windows desktop.

3 If you want to use EVIDAS as a free viewer for data files, proceed here:
Using EVIDAS as a viewer, 22

4 If you want to test a full version of EVIDAS for 30 days, proceed here:
Using a trial version of EVIDAS, 21

5 If you want to use an EVIDAS single license:
a) Purchase a single license, e.g., through the HBM online shop. You

receive an email with an activation key.
b) Proceed with one of the following options:

Activating an EVIDAS single license online, 13
Activating an EVIDAS single license manually, 15

6 If you want to use an EVIDAS network license, proceed here:
Registering for an EVIDAS network license, 19
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1.2 Activating EVIDAS

To work with EVIDAS, you must activate it, i.e., specify that you are an 
authorized user. Activation is a secure process in which the product features 
are enabled.

How you activate EVIDAS, depends on the license type you have.

Network license

Your organization has purchased and installed EVIDAS network licenses to 
be shared by authorized users:

Registering for an EVIDAS network license, 19

Single license

You have purchased an EVIDAS single license and received an email with an 
activation key.

To activate an EVIDAS single license on an online computer:

Activating an EVIDAS single license online, 13

To activate an EVIDAS single license on an offline computer:

Activating an EVIDAS single license manually, 15

No license

If you do not have a license, you can still use EVIDAS:

 Using EVIDAS as a viewer, 22
 Using a trial version of EVIDAS, 21
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1.2.1 Activating an EVIDAS single license online

Use this procedure to activate an EVIDAS single license on an online 
computer.

Prerequisites

 EVIDAS is downloaded and installed (Installing EVIDAS, 11).
 EVIDAS single license is purchased.
 Internet connection.

To activate an EVIDAS single license online

1 Double-click .
 The EVIDAS activation dialog box is displayed.

2 Select Activate licensed version.

3 Enter your activation key and email address.

4 Click Next.
 The EVIDAS activation options are displayed.
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5 Select Online.

6 Click OK.
 Please wait until notified that EVIDAS is activated.
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1.2.2 Activating an EVIDAS single license manually

Use this procedure to activate an EVIDAS single license on an offline 
computer.

Prerequisites

 EVIDAS is downloaded and installed (Installing EVIDAS, 11).
 EVIDAS single license is purchased.
 Internet connection via a second computer.

To activate an EVIDAS single license manually

1 Double-click .
 The EVIDAS activation dialog box is displayed.

2 Select Activate licensed version.

3 Enter your activation key and email address.

4 Click Next.
 The EVIDAS activation options are displayed.
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5 Select Manually.

6 Click Copy link and paste the URL to the address bar of your web browser.
 The HBM License Activation webpage is displayed.

7 Enter your email address and activation key.
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8 In EVIDAS, in the Activation options dialog box, click Copy ID and paste 
it to the Machine ID text box on the HBM License Activation webpage.

 Alternatively to steps 7 and 8, in Activation options, click Save as to 
save the activation data to a file. On the HBM License Activation 
webpage, click BROWSE and navigate to the file you created, and then 
click PROCESS to fill in the activation data from the file.

9 Click ACTIVATE LICENSE.
 You will receive an email with a license file.

10 Copy the license file to a folder on the offline computer.

11 On the offline computer, double-click .
 The EVIDAS activation dialog box is displayed.
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12 Select I already have a license file and navigate to it.

13 Click OK.
 Please wait until notified that EVIDAS is activated.
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1.2.3 Registering for an EVIDAS network license

If your organization has installed EVIDAS network licenses on a license 
server, use this procedure to register for using a network license.

You can then use EVIDAS on your computer whenever at least one of the 
network licenses is available. If you quit EVIDAS, the license is returned to 
the pool of network licenses and available to another authorized user.

If you plan to work away from your network, you can request to borrow a 
network license and take it with you for a limited period of time (Borrowing an 
EVIDAS network license, 37).

Prerequisites

 EVIDAS is downloaded and installed on your computer (Installing
EVIDAS, 11).

 EVIDAS network licenses are installed on a license server.
 Your network administrator provided you with the name and port of the

license server.
 Network connection.

To register for an EVIDAS network license

1 Double-click .
 The EVIDAS activation dialog box is displayed.

2 Click Network license.

 The License server dialog box is displayed.
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3 Enter the name and port of the license server.

 If you do not know the name and port of the license server, contact your 
network administrator.

4 Click OK.
 You are now registered to use an EVIDAS network license.
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1.2.4 Using a trial version of EVIDAS

Use this procedure to test a full version of EVIDAS for 30 days.

Prerequisites

 EVIDAS is downloaded and installed (Installing EVIDAS, 11).

To use a trial version of EVIDAS

1 Double-click .
 The EVIDAS activation dialog box is displayed.

2 Select Use as trial version.

3 Click Next.
 A trial version of EVIDAS is started.
 To activate an EVIDAS single or network license, click File > Info
> Activate software (File, 219).



22 A04766_01_E00_04 

EVIDAS

1.2.5 Using EVIDAS as a viewer

Use this procedure to activate EVIDAS as a free viewer for data files (*.pnrf).

Prerequisites

 EVIDAS is downloaded and installed (Installing EVIDAS, 11).

To use EVIDAS as a viewer 

1 Double-click .
 The EVIDAS activation dialog box is displayed.

2 Select Don’t activate and use as viewer version.

3 Click OK.
 EVIDAS is started in viewer mode.
 To test a full version of EVIDAS for 30 days or to activate an EVIDAS
single or network license, click File > Info > Activate software
(File, 219).
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1.3 Activating the HBM cloud

You must activate the HBM cloud (HBM cloud, 208) before you can upload 
data files to it.

Prerequisites

 EVIDAS is activated (Activating EVIDAS, 12).
 Internet connection.

To activate the HBM cloud

1 Click the File tab.

2 Click Info.

3 Click Activate HBM cloud ....
 The HBM cloud activation dialog box is displayed.

4 Select the location you want your data to be stored at, e.g.:

 A redundant location is specified automatically for the event that the 
cloud at the prefered location fails, e.g., due to maintenance work. The 
redundant location holds a backup of your cloud data.

5 Click Activate.
 The HBM cloud is activated. You receive an email with a link and a
password for web login (HBM cloud storage website, 209).
 You can specify that EVIDAS automatically uploads a copy of each new 
data file to the HBM cloud (Cloud storage, 138).
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1.4 Getting started

To start EVIDAS

1 On the Windows desktop, double-click .
 The program is started.

 If you already have an EVIDAS project file (*.evidas), double-click the 
filename to start EVIDAS and to open the project. The default folder for 
project files is C:\Users\Public\Documents\HBM\EVIDAS\Projects. 
Alternatively, use File > Open (Opening a project, 71).

A Ribbon, 39 C Sensors panel, 230

B Devices panel, 104 D Project channels panel, 107

BA

DC
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To visualize a channel

1 In Devices, click a channel and drag it to Project channels.

2 In Sensors, enter the required sensor type into the search box, e.g., U9B 
for a force transducer.
 The matching sensors are displayed.

3 Click the appropriate sensor and drag it to the project channel.
 The project channel is configured with the settings from the sensor
database.

 In the Sensor / Transducer type column, indicates that the settings 
are taken from the sensor database.

4 Click the project channel.

5 Click Balance to determine a zero value for the unloaded sensor.

1

3

2

4

5
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6 Click the Visualization tab.

7 Drag the project channel to Panel 1 and click, e.g., Insert y(t) chart.
 An empty chart is displayed.

8 Click Start.
 The measured values are visualized and saved in a file.

9 Click Freeze to pause or continue visualization.

10 Click Stop to stop data acquisition.

11 Click the Data manager tab.

12 Click the file containing the measured values.
 The traceability data of the measurement is displayed below the file list.

6

7

8 9

10

11

12
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1.5 Getting help

You have the following options to get help on EVIDAS:

Type of Assistance Description

Online help Contains a full description of EVIDAS.
To open and search the online help, see:
Online help, 28
Searching the online help, 32

Printable help (PDF) Contains a full description of EVIDAS.
To open the printable help file, see:
Info panel, 222

Support website To access the support website, see:
Info panel, 222
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1.5.1 Online help

To open the online help, press F1.

 EVIDAS online help

The online help contains a full description of EVIDAS.

You can change the size and position of the online help window. These 
settings are applied the next time you open the online help.

 Getting help on a panel, 29
Getting help on an icon, 30
Getting help on a visualization object, 31
Searching the online help, 32

A Table of contents tab D Search text box

B Index tab E Navigation panel

C Search tab F Content panel

FE

A DB C
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1.5.2 Getting help on a panel

Each panel in EVIDAS has a burger menu, and each burger menu has a link 
to the online help.

Prerequisites

 EVIDAS is started.

To get help on a panel

1 Click the burger menu button  of any panel, e.g., of the Devices panel.

 The burger menu is displayed.

2 On the burger menu, click the Help on … entry.

 The online help displays information on the respective panel.
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1.5.3 Getting help on an icon

On the ribbon, each icon has a tooltip. Some tooltips have a link to the online 
help.

Prerequisites

 EVIDAS is started.

To get help on an icon

1 Point to an icon, e.g., on the Channels tab, point to  Configure.
 A tooltip is displayed.

 If the tooltip contains an F1: More on … line, you can get context-
sensitive help.

2 While the tooltip is displayed, press F1.
 The online help displays information on the respective icon.
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1.5.4 Getting help on a visualization object

Each visualization object, e.g., a y(t) chart, offers a link to the online help.

Prerequisites

 EVIDAS is started.

To get help on a visualization object

1 On the visualization panel, right-click an object, e.g., a y(t) chart.
 The context menu is displayed.

2 On the context menu, click the Help on … entry.
 The online help displays information on the contextual tab set of the
visualization object.
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1.5.5 Searching the online help

Prerequisites

 The EVIDAS online help is displayed.

To search the online help

1 In the search text box, enter a search string, e.g., linear.

2 Press Enter.
 On the navigation panel, the search results are displayed.

 Topics that contain the search string in their heading are displayed at 
the top of the list. Headings are displayed in bold print.
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3 Click a search result.
 The content is displayed and the search string is highlighted.

 You can search for any string or substring, e.g., linear, linea, line, or 
lin.
To search for a phrase, you must enclose it in quotation marks, e.g., “non-
linear characteristic”.
If you use several search strings at once, e.g., background and color, the 
default search is an OR-search, i.e., all topics that contain either 
background or color are search results.
If you want the search results to contain both search strings, select the 
Show results that include all search words option.
You can also use the Boolean operators AND, OR, and NOT in a search 
string, e.g., background AND NOT color.
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1.6 Renewing an EVIDAS license

When purchasing an EVIDAS license, you normally receive one year of 
maintenance with it which includes:

 Updates of EVIDAS.
 Access to the HBM cloud.
 HBM support.

Once the maintenance period expires, you need to purchase an extension of 
maintenance, e.g., for another year.

After purchasing, you receive an e-mail that contains a new EVIDAS license 
file (*.lic).

Proceed with one of the following procedures:

 Renewing an EVIDAS single license on an online computer, 35
 Renewing an EVIDAS single license on an offline computer, 36
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1.6.1 Renewing an EVIDAS single license on an online computer

Prerequisites

 EVIDAS is installed and activated (Activating an EVIDAS single license
online, 13).

 EVIDAS maintenance extension is purchased.
 Internet connection.

To renew an EVIDAS single license online

1 Click the File tab.

2 On the Info panel, click the License manager button.

 The License manager dialog box is displayed.

3 On the Renew tab, select I use an Internet connection.

4 Click Renew.
 Your computer connects to the EVIDAS license activation center. The 
EVIDAS license file on your computer is identified and replaced by a new 
license file specifying the maintenance extension you purchased.



36 A04766_01_E00_04 

EVIDAS

1.6.2 Renewing an EVIDAS single license on an offline computer

Prerequisites

 EVIDAS is installed and activated (Activating an EVIDAS single license
manually, 15).

 EVIDAS maintenance extension is purchased.
 Internet connection via a second computer.

To renew an EVIDAS single license offline

1 Copy the EVIDAS license file that you received in the confirmation e-mail
to the offline computer.

2 Click the File tab.

3 On the Info panel, click the License manager button.

 The License manager dialog box is displayed.

4 On the Renew tab, select I use a license file and navigate to the new 
license file.

5 Click Renew.
 The EVIDAS license file on the offline computer is replaced with the new 
license file. The new license file specifies your maintenance extension.
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1.7 Borrowing an EVIDAS network license

If you use an EVIDAS network license and need to work with EVIDAS while 
being away from your network, you can borrow a license to take with you.

Prerequisites

 You are registered for using an EVIDAS network license (Registering for
an EVIDAS network license, 19).

To borrow an EVIDAS network license

1 Click the File tab.

2 On the Info panel, click the License manager button.

 The License manager dialog box is displayed.

3 On the Borrow tab, select Borrow license and the number of days you 
want to borrow.

4 Select Return borrowed license when reconnect to network.
 Alternatively, you can choose to return a borrowed license manually. In 
this case, do not select Return borrowed license when reconnect to 
network.
However, when reconnecting to your network, you must then open the 
Borrow tab again, select the Return borrowed license now option, and 
click OK.

5 Click OK.
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2 User interface
2.1 Ribbon

A ribbon is a command bar that helps you to find and use commands with a 
minimum number of clicks.

2.1.1 Ribbon elements

The EVIDAS ribbon organizes the program’s features into a series of tabs. 
Each tab contains commands for a specific part of the measuring task. The 
commands are grouped and labeled.

Tab

A tab contains commands for a specific part of the measuring task (Ribbon 
commands, 41), e.g., for configuring project channels.

The tabs are organized from left to right following the measurement workflow 
from channel configuration to review and export.

To display a tab, click its label, e.g., Channels.

Group

A group is a set of related commands, e.g., to start and stop data acquisition.

A Tab, 39 F Start / Stop button, 40

B Collapse / Expand button, 40 G Freeze button, 40

C Group, 39 H In-Ribbon Gallery, 40

D Command, 40 I Contextual tabs, 43

E Dialog Box Launcher, 40 J Status panel, 41

E

BA

C D

H IF JG
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Command

A command either performs a specific function directly, e.g., Delete, or 
displays options in a dialog box or menu, e.g., Rename.

Frequently used commands have large buttons, e.g., Start and Stop.

 Start /  Stop button

The following commands are available on all tabs:

 Freeze button

This command is available on the Visualization tab:

 Dialog Box Launcher 

Click this button to open a dialog box for defining group-related settings, e.g., 
to assign sample rates to the Slow, Medium, and Fast buttons 
in the Sample rate group.

 Collapse /  Expand button

Click  to collapse the ribbon. Click  to expand the ribbon.

Alternatively, press Ctrl+F1 or double-click a tab to collapse and expand the 
ribbon.

In-Ribbon Gallery

On the Visualization tab, the In-Ribbon Gallery displays the available 
visualization object types.

Command Description

Start To start data acquisition.
EVIDAS will switch to Visualization and start recording.
If you did not define any visualization objects, EVIDAS 
will visualize the first four active project channels in 
y(t) charts, digital meters, and a data table.

Stop To stop data acquisition.

Command Description

Freeze To pause or continue the visualization of all signals in all 
charts on the visualization panel, e.g., y(t) charts, 
X-Y charts, and FFT charts.
Meanwhile, data acquisition continues in the
background.
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2.1.2 Ribbon commands

The following links explain the commands on the ribbon:

 Channels tab, 74
Online calculations tab, 112
Visualization tab, 146
Data manager tab, 203
Sensor manager tab, 228

2.1.3 Status panel

The status panel is displayed in the right upper corner of the ribbon.

On the Visualization tab (Visualization commands, 146), if you click 
Full screen, the status panel turns into a floating panel, the Acquisition 

control panel.

To exit full screen mode, click  on the visualization panel header or press 
Esc (Visualization panel, 177).

Acquisition status

A Acquisition status, 41 C Burger menu, 42

B Time count, 42 D Notifications, 42

A Start / Stop button, 40 D Time count, 42

B Freeze button, 40 E Burger menu, 42

C Acquisition status, 41 F Notifications, 42

EVIDAS is waiting for the operator to click Start.

EVIDAS is zero balancing the project channels before recording 
(Zero-balance option, 133).
EVIDAS is waiting for a start trigger condition to be fulfilled (Trigger 
options, 129).
EVIDAS is recording.

EVIDAS is waiting for a repeated recording to start automatically 
(Repeat recording options, 133).

CBA D

CA B D E F
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Time count

Burger menu

Notifications

To display, click  or .

The Notifications dialog box allows you to monitor the connection to the 
devices during recording. indicates at least one lost connection.

Once you stop the recording, the list of notifications is cleared.

Clear list button

Click this button to clear the list of notifications. The notifications icon is reset 
to .

 Device lost behavior, 134

Event Display

Before recording 00:00:00 (if this is the first recording)
During zero balancing 00:00:00
During recording Time elapsed since start of recording.
Waiting for repeated recording Countdown until start of repeated recording.
After recording Duration of the last recording.

Command Description

Help on status panel To access context-sensitive help.

A Signal status icons, 109 B Clear list button, 42

B

A
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2.1.4 Contextual tabs

If you click a visualization object, e.g., a y(t) chart, a contextual tab set is 
displayed (Visualization panel, 177).

Contextual tab sets

EVIDAS has one contextual tab set for each visualization object, e.g., for 
y(t) charts (Contextual tabs for visualization objects, 150).

The contextual tab sets contain commands to edit the visualization objects.

Selected object

To select a visualization object, click the object, e.g., a digital meter on the 
visualization panel.

The object is displayed with a grey frame and can be configured with the 
commands on the contextual tab.

A Contextual tab sets, 43 B Selected object, 43

A

B
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2.1.5 Modal tabs

EVIDAS has one modal tab, the Sensor manager tab. While working on this 
tab, you cannot switch to other tabs.

To display the Sensor manager tab, on the Channels tab, click Manage.

To return to Channels, click Return to Channels.

 Sensor manager tab, 228
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2.2 Panels

For each tab, the area below the ribbon contains one or more panels, e.g., 
the Devices panel, Sensors panel, and Project channels panel below the 
Channels tab (Channels, 73).

2.2.1 Panel elements

Each panel provides a specific functionality, e.g., to display the available data 
acquisition devices or to access the sensor database.

A panel has a border, a header, and a content area. Some panels have a 
search box (Search box, 45). You can resize a panel, change its position in 
the panel area (Docking, 51), or hide it (Auto Hide, 50).

Header

The panel header has a title and buttons to modify the display of the panel 
and its contents.

To change the position of a panel, point to the header and drag the panel to 
the desired position (Docking, 51).

Search box

A search box enables you to search the content of a panel, e.g., the sensor 
database. As you type a search string, the result is displayed immediately 
and shows all entries containing the search string (Search box, 47).

Content area

The content area displays the content of the panel, e.g., the data acquisition 
devices and sensors connected to EVIDAS.

In some panels, a tree view is used to display the content (Tree view, 49).

A Header, 45 D Active panel bar, 46

B Search box, 45 E Burger menu button, 46

C Content area, 45 F Auto Hide button, 46

A B D FC E
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Active panel bar

The active panel bar is an orange line that is displayed when you click a 
panel.

 Burger menu button

Click this button to display commands related to the panel, e.g., to add a data 
acquisition device to the Devices panel.

With the burger menu, you can access context-sensitive help.

 Auto Hide button

Click this button to hide a panel. A vertical tab is displayed instead, e.g.:

Click the vertical tab to display the panel temporarily.

Click away from the temporary panel to hide it again or click to restore it to 
its previous size and position (Auto Hide, 50).
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2.2.2 Search box

A search box enables you to search the content of a panel, e.g., the sensor 
database.

Search box

To filter the content of a panel, enter a search string into the search box.

Search string

As you type the search string, the result is displayed immediately and shows 
all entries containing the search string, e.g., first for u, then for u2, then for 
u2a.

 Search icon

Identifies the text box as a search box.

Delete button

A Search box, 47 D Delete button, 47

B Search string, 47 E Filter menu button, 48

C Search icon, 47

No search string or selection on filter menu (Filter menu button, 48).

The panel content has been filtered with a search string or with the filter 
menu (Filter menu button, 48).
Click this button to delete the search string. However, this does not affect 
the selection on the filter menu.

B DC E

A
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 Filter menu button

This button is available on the Sensors panel and displays the following filter 
menu that allows you to filter the sensor database prior to applying a search 
string.

Filter check boxes

To narrow the search, select one or more check boxes.

If you select a check box, the Delete button is displayed in red.

Clear all button

Click this button to clear the selection.

Close button

Click this button to save the selection and close the filter menu.

A Filter check boxes, 48 C Close button, 48

B Clear all button, 48

A B C
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2.2.3 Tree view

Some panels, e.g., the Sensors panel, use a tree view to display their 
content.

Click the following icons to expand / collapse the folders:

Alternatively, double-click the text following the icon.

Expand, i.e., display items on level below.

Collapse, i.e., hide items on level below.
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2.2.4 Auto Hide

You can maximize panels by hiding other ones. You can only hide panels that 
are docked to one of the edges of the panel area (Docking, 51).

Vertical tabs

A vertical tab represents a hidden panel. Click a vertical tab to display the 
hidden panel temporarily (Auto Hide button, 46).

Click away from the temporary panel to hide it again.

Auto Hide button

A Vertical tabs, 50 B Auto Hide button, 50

A B

To hide a panel.

To restore a hidden panel to its previous size and position.
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2.2.5 Docking

You can undock a panel from its position and dock it to a new one 
(Rearranging panels, 53). You can only undock and dock panels that are 
not hidden (Auto Hide, 50).

The following illustration shows the screen elements related to docking:

Floating panel

A floating panel is a panel that has been undocked from its position and can 
be dragged to any position on the screen.

To undock a panel, point to its header and drag the panel from its position.

A floating panel can be docked to the following elements:

 The border of the panel area.
 The border of another panel.
 Another panel.

A Floating panel, 51 B Docking buttons, 52

BBA

B B B
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Docking buttons

To dock a floating panel, point to its header, drag it from its position, and then 
point to one of the docking buttons.

A grey frame indicates the docking position related to the button.

Release the pointer to dock the floating panel.

Tabbed panel

A tabbed panel contains several panels.

Click a tab to display the respective panel.

You can undock and dock a tabbed panel in the same way as a single panel.

To undock a panel from a tabbed panel, point to its tab and drag the panel 
from its position.

 Rearranging panels, 53

Button Name Description

Dock-to-panel-area buttons Use these buttons to dock a floating panel to one of the 
edges of the panel area.

Dock-to-panel buttons Use these buttons to dock a floating panel to one of the 
borders of another panel.
As you drag a floating panel on top of another panel, these 
buttons are displayed on the panel below.

Tabbed-panel button Use this button to dock a floating panel on top of another 
panel. A tabbed panel is displayed (Tabbed panel, 52).

A Tabbed panel B Tabs

B

A
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2.2.6 Rearranging panels

Using the panels in Channels as an example, this procedure explains how to 
rearrange panels.

To rearrange panels

1 Click the Channels tab.

2 In Devices, click the header and hold down the pointer.

3 Drag the Devices panel onto the Project channels panel.

 The docking buttons are displayed.
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4 Point to the right dock-to-panel button and release the pointer.

 The Devices panel is docked to the right of the Project channels
panel.

5 In Sensors, click the header and hold down the pointer.

6 Drag the Sensors panel onto the Devices panel.

 The docking buttons are displayed.
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7 Point to the tabbed-panel button and release the pointer.

 The Sensors panel and the Devices panel are grouped together on a
tabbed panel.

8 In Project channels, point to the right panel border and drag it to the 
desired position.
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3 Project setup
An EVIDAS project is a set of configured channels for a measuring task that 
is saved in an EVIDAS project file (*.evidas). The default folder for project 
files is C:\Users\Public\Documents\HBM\EVIDAS\Projects.

To set up and work with a project, you must perform the following steps:

 Starting a new project, 58
 Selecting project channels, 59
 Configuring project channels, 60
 Saving a project, 70
 Opening a project, 71

In addition to the configured channels, the following settings are saved in the 
project file:

 Calculation channels (Online calculations, 111).
 Recording options (Start options, 127).
 Storage options (Data default folder and file name, 136).
 Visualization items (Visualization, 145).
 Review channels (Project channels panel in Data manager, 210).

However, information about the status of the panels, e.g., the auto hide status 
(Auto Hide, 50) or docking status (Docking, 51), is not stored in the 
project file.
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3.1 Starting a new project

To start a new project, you must clear all current project channels and related 
settings in EVIDAS.

If you still need the project channels, save them in a project file (To save a 
project, 70).

To start a project

1 Click the File tab.

2 Click New.

 The current project channels and related settings are deleted.
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3.2 Selecting project channels

You can select one channel, a group of channels, or all channels of a data 
acquistion device as project channels.

Prerequisites

 Data acquisition device and sensors are connected.
 EVIDAS is started.

To select project channels

1 Click the Channels tab.

2 In Devices, click a data acquisition device and drag it to Project channels.

 All channels of the data acquisition device are project channels.

 In the Measured value column, a live representation of the measured 
values is displayed.
 The All tab displays all project channels. The other tabs display 
subgroups of channels (Project channels panel, 107).
 You only want a selection of channels as project channels? In Devices, 
hold down Ctrl while clicking the required channels. Or, hold down Shift 
while clicking the first and last of a range of channels. Drag the selected 
channels to Project channels.
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3.3 Configuring project channels

You have the following options to configure a project channel:

A

B

D

C

 Options to configure project channels

Option Procedure Description

A Configure with TEDS sensor, 61 The project channel is configured automatically with the sensor 
settings from the TEDS (Transducer Electronic Data Sheet) chip in 
the TEDS connector / sensor.

B Configure with HBM sensor database, 62 The project channel is configured with the default sensor settings 
from the HBM sensor database. For higher accuracy, you can enter 
the sensor settings from the sensor data sheet (Configure in 
Configure channel dialog box, 64).

C Configure in Configure channel dialog 
box, 64

You can configure a single project channel in the Configure 
channel dialog box.

D Configure on Project channels panel, 67 You can configure project channels on the Project channels panel.



A04766_01_E00_04 61

EVIDAS

3.3.1 Configure with TEDS sensor

A TEDS sensor has a connector with a built-in TEDS (Transducer Electronic 
Data Sheet) chip that contains the sensor settings.

Prerequisites

 Data acquisition device is connected.

To configure a project channel with a TEDS sensor

1 Connect the TEDS sensor to the data acquisition device.

2 Click the Channels tab.

3 In Devices, drag the respective project channel to Project channels.

4 In Project channels, click the channel.

 The channel is highlighted.

5 Click TEDS, and then click Activate.

 EVIDAS scans the selected channel, reads the sensor settings from the
TEDS chip, and configures the project channel automatically. Even if you
connect the TEDS sensor later, the settings from the TEDS chip will be
used.
 In Project channels, the sensor is identified as TEDS sensor.

 TEDS options, 88
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3.3.2 Configure with HBM sensor database

You can configure a channel using the default sensor settings from the HBM 
sensor database.

Prerequisites

 Data acquisition device and sensors are connected.
 Project channels are selected (To select project channels, 59).

To configure a project channel with the HBM sensor database

1 In the Sensors search box, enter the required sensor type, e.g., U9B for a
HBM force transducer.

 The matching sensors are displayed.
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2 Click the appropriate sensor and drag it to its project channel.

 The project channel is configured with the settings from the sensor
database.
 In the Sensor / Transducer type column, indicates that the settings 
are taken from the sensor database.

 For higher accuracy, you can enter the sensor settings from the sensor 
data sheet (Configure in Configure channel dialog box, 64).
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3.3.3 Configure in Configure channel dialog box

You can configure a single project channel in the Configure channel dialog 
box (Configure channel dialog box, 76).

Prerequisites

 Data acquisition device and sensors are connected.
 Project channels are selected (To select project channels, 59).

To configure a project channel in the Configure channel dialog box

1 In Project channels, click a channel.

2 Click Configure.
 The Configure channel dialog box is displayed.

 Alternatively, to open this dialog box, double-click the row header of the 
channel.

3 Select a sensor type, sample rate, and filter for the channel.
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4 Check if the pinning of the sensor matches the wiring diagram of the sensor 
type (Channel settings, 77).

5 On the Transducer settings tab, enter the sensor settings from the sensor 
data sheet.
 Alternatively, you can calibrate the sensor by using your own calibration 
points, e.g., for the linear characteristic Scaling type = Two point by 
defining P1 = (0.1 mV/V | 0 μm/m) and P2 = (2.2 mV/V | 10.5 μm/m).

 If you need the actual electrical values for P1 and P2 while the sensor 
is under a defined load, click Measure electrical value.

The Measure electrical value buttons are available for linear 
calibration characteristics, i.e., for the Zero span, Two-point, and Table 
scaling types (Scaling type, 238).

6 For the signal preview chart, if you want the scale of the y-axis to adjust 
automatically to the range of measured values, select the Autoscaling 
check box. 
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7 If you want a fixed scale, clear the Autoscaling check box, and then define 
a range of physical values on the Transducer settings tab.

 The notification bar is displayed.

8 To apply the changes, click Apply and then click OK.
 After changing a setting, you must rebalance the channel (Zero balance 
commands, 101).

9 If you want to create a user-defined sensor from your settings, on the 
Sensor information tab, enter a sensor name and the other metadata 
needed, and then click Create sensor.
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3.3.4 Configure on Project channels panel

You can configure project channels directly on the Project channels panel 
with one of the following actions:

 Select an option from a drop-down list.
 Type a setting into a table cell.
 Copy settings from one project channel to another.

Prerequisites

 Data acquisition device and sensors are connected.
 Project channels are selected (To select project channels, 59).

The following procedure illustrates your options.

To configure project channels on the Project channels panel

1 In Project channels, click a tab that contains a subgroup of channels, e.g.,
the Voltage tab.
 On the All tab, you can edit the global channel settings. On the other 
tabs, you can edit the sensor settings (Project channels panel, 107).

2 Edit the sensor settings, e.g.:

 The new settings are saved automatically.

3 Click the All tab.

 In the Sensor / Transducer type column, indicates that the settings 
have been changed.
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4 In the Sensor / Transducer type column, right-click the sensor, and then 
click Create sensor from channel settings.

 The sensor is renamed and saved as a user-defined sensor.

5 In the Sensor / Transducer type column, click the sensor again.
 In the right corner of the table cell, a red triangle is displayed.

6 Point to the red triangle. When the pointer turns into a , drag the pointer 
to copy the sensor and its settings to the other project channels.

 The sensor is copied to the other channels.
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7 Click the Voltage tab.
 All project channels are now configured with the same sensor settings.
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3.4 Saving a project

If you want to reuse a set of project channels, you must save them to a 
project file.

Prerequisites

 Project channels are selected (To select project channels, 59).
 Project channels are configured (Configuring project channels, 60).

To save a project

1 Click the File tab.

2 Click Save.

 The Explorer is displayed.

3 Enter a filename.

4 Click Save.
 The project channels and all related settings are saved in a project file
(*.evidas).

 File menu, 220
Opening a project, 71
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3.5 Opening a project

Prerequisites

 A project file (*.evidas) is available (Saving a project, 70).

To open a project

1 Click the File tab.

2 Click Open.

 The recently opened project files are displayed.

3 Click  Browse and navigate to the project file.
 The default folder for project files is 
C:\Users\Public\Documents\HBM\EVIDAS\Projects.

4 Click Open.
 The project channels and all related settings are loaded.
 If a data acquisition device is required by the project, but is not 
connected to the system, a hardware mapper is displayed (Hardware 
mapper, 72).
 Alternatively, use Windows Explorer to navigate to the project file, and 
then double-click the project file.

 File menu, 220
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3.6 Hardware mapper

To display, click the File tab, click Open, and then click a project file (*.evidas) 
that requires a data acquisition device which is currently not connected to the 
system.

You have the following options to proceed with loading the project:

A Name of device not found B Options to proceed with loading the project

Option Description

Replace this device with To use another device, from the drop-
down list, select one of the devices that 
are connected to the system.

Skip this device and continue loading To skip the device not found and to 
continue loading the project.
You may connect the required device 
after loading the project.

Skip all remaining devices To skip the device not found and to skip 
all other devices required by the project, 
but not connected to the system, and to 
continue loading the project.
You may connect the required devices 
after loading the project.

A

B
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4 Channels
On the Channels tab and its panels, you select and configure the project 
channels.

A Channels tab, 74 C Sensors panel, 230

B Devices panel, 104 D Project channels panel, 107

C

A B

D
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4.1 Channels tab

Some commands on the Channels tab display a dialog box or menu with 
further commands or options.

A Channels command groups, 75 E Filter options, 97

B Configure channel dialog box, 76 F Zero balance commands, 101

C TEDS options, 88 G Zero balance options, 103

D Sample rate group and domain options, 89 H Appendix A: Sensor manager, 227

A B C D E F G H
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4.1.1 Channels command groups

 Start / Stop button, 40

Group Description

Project channels To select channels as project channels or to delete project 
channels from the Project channels panel (Project 
channels panel, 107).

Channel 
configuration

To configure project channels.

Click a project channel, and then click Configure to 
display the Configure channel dialog box (Configure 
channel dialog box, 76).
Click TEDS to display options for TEDS sensors (TEDS 
options, 88).

Sample rate To define sample rate groups and sample rate domains.
Click  to display the Sample rate groups dialog box 
(Sample rate group and domain options, 89).

Filter To define a filter for a project channel.

Click a project channel, and then click Filter to display 
filter options for the channel (Filter options, 97).

Zero To zero balance project channels.
Hold down Ctrl while clicking the project channels you want 

to balance, and then click Balance.
To display all commands related to zero balancing, click a 
channel, and then click Balance (Zero balance 
commands, 101).
Click  to define how zero values are determined (Zero 
balance options, 103).

Sensors To display and edit sensor settings.

Click Manage to display the Sensor manager tab 
(Appendix A: Sensor manager, 227).
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4.1.2 Configure channel dialog box

To display, click the Channels tab, click a project channel, and then click 
Configure.

In this dialog box, you can configure a single project channel. If you edit a 
setting, a notification bar is displayed.

To apply a change, click Apply.

After changing a setting, you must rebalance the channel (Zero balance 
commands, 101).

A Channel settings, 77 C Signal preview, 78

B Previous / Next buttons, 77 D Sensor settings, 79

A

B C D
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Channel settings

You can edit the channel name and change the sensor type, sample rate, and 
filter for the channel.

The wiring diagram shows which sensor wire should be soldered to which 
connector pin.

The colors displayed for the wires are the standard HBM wire colors.

For detailed pinning information, point to the diagram. A tooltip is displayed.

Make sure that the pinning of your sensor matches the wiring diagram.

 Previous /  Next buttons

Click  or  to display the previous or next project channel from the list on 
the Project channels panel.
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Signal preview

The signal preview displays a real-time trace of the signal without starting 
data acquisition.

If you want the scale of the y-axis to adjust automatically to the range of 
measured values, select the Autoscaling check box.

If you want a fixed scale, clear the Autoscaling check box, and then define a 
range of physical values on the Transducer settings tab.

A Signal status C Real-time trace

B Live measured value D Autoscaling check box

A

D

B

C
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Sensor settings

On the following tabs, you can edit the sensor settings, create user-defined 
sensors, and enter temperature correction parameters.

Transducer settings

To edit the sensor settings, e.g., to match the settings on the sensor data 
sheet (Transducer settings, 237).

Sensor information

To edit the metadata of the sensor, e.g., the sensor name and its calibration 
date. You can create user-defined sensors.

Temperature correction

This tab is displayed for strain gauges (quarter bridge). You can compensate 
for unwanted temperature effects on the measured values (Temperature 
correction, 82).

A Transducer settings, 79 D Measuring range, 80

B Sensor information, 79 E In use bar, 80

C Temperature correction, 79 F Calibration parameters, 81

A B D EC

F
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Measuring range

The measuring range is defined by a minimum and a maximum physical 
value between which you expect the measured values to be. On the 
y(t) chart, the measuring range is displayed on the y-axis if you use the 
scaling type from the sensor settings (Y-axes tab for y(t) charts, 154).

In use bar

The In use bar displays the measuring range in relation to the total voltage 
range available from the amplifier.

If your measuring range is too small in relation to the total available range, the 
measuring resolution might be insufficient and the measured values could 
turn out inaccurate.

A Minimum value of total range D Maximum value of measuring range

B Minimum value of measuring range E Maximum value of total range

C Zero point

A B C D E
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Calibration parameters

The calibration characteristic of a sensor is defined by a scaling type (Scaling 
type, 238) and a set of calibration parameters pertaining to the scaling type 
which together specify how a valid range of electrical values is mapped to the 
corresponding physical values.

For linear calibration characteristics, i.e., Zero span, Two-point, and Table, 
you can either use the settings from the sensor data sheet or specify two or 
more calibration points P1, P2, etc.

Example: Scaling type = Two point

 P1 = (0.1 mV/V | 0 μm/m)
 P2 = (2.2 mV/V | 10.5 μm/m)

If you need the actual electrical values for P1 and P2 while the sensor is 
under a defined load, click Measure electrical value.

The Measure electrical value buttons are available for linear calibration 
characteristics, i.e., for the Zero span, Two-point, and Table scaling types 
(Scaling type, 238).

For non-linear calibration characteristics, e.g., Polynomial, you must enter 
the polynomial coefficients from the sensor data sheet (Transducer 
settings, 237).
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4.1.3 Temperature correction

To display, click the Channels tab, click a project channel, click 
Configure, and then click the Temperature correction tab.

Strain gauges (quarter bridge) that are operated in an environment with a 
temperature that deviates from the usual reference temperature of 20°C may 
deliver skewed measured values due to thermal expansion or contraction of 
the materials involved.

On the Temperature correction tab, you can compensate for unwanted 
temperature effects on the measured values.

A Temperature correction options, 83 B Temperature correction parameters, 84

A

B
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Temperature correction options

Option Description

No correction required The strain gauge is operated in an environment with a temperature of 20°C to 25°C, 
e.g., in a laboratory.

Correct with a strain gauge on 
channel

The strain gauge is operated in an environment with a temperature that deviates 
significantly from the reference temperature of 20°C, e.g., in a range from 0°C to 
40°C.
For each strain gauge used, you must specify a second identical strain gauge 
which is placed in the vicinity of the first one, without being exposed to strain.
EVIDAS then automatically compensates for undesirable temperature effects on 
the measured values.

Correct by measuring temperature 
T on channel

The strain gauge is operated in an environment with a temperature that deviates 
significantly from the reference temperature of 20°C, e.g., in a range from 0°C to 
40°C.
You must specify a temperature channel that measures the ambient temperature. A 
single temperature channel is sufficient for all strain gauges involved.
You must enter the temperature correction parameters (Temperature correction 
parameters, 84) from the respective data sheet (Strain gauge data sheet, 87).
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Temperature correction parameters

If you use temperature correction with a temperature reference channel 
(Temperature correction options, 83), you must enter the following 
temperature correction parameters from the sensor data sheet:

 Temperature correction parameters when using temperature reference channel

Parameter Description

Reference temperature on data 
sheet

The reference temperature is specified in the polynomial on the data sheet (Strain gauge 
data sheet, 87), e.g.:

You must enter the reference temperature on the Temperature correction tab.

At reference temperature, the measured values are not skewed, i.e., the temperature-
dependent correction εs ≈ 0.

Thermal expansion parameters HBM determines the temperature correction parameters of the strain gauge while it is 
attached to a specific material, e.g., to steel. The thermal expansion of the material is 
specified by the thermal expansion coefficient α (Strain gauge data sheet, 87), e.g.:

You must enter α into the first text box of the Thermal expansion parameters section, 
e.g. 10.8 for steel. If you use the same material as on the data sheet, you must enter α
also into the second text box.

If the material on which you use the strain gauge is different, you must enter the 
respective thermal expansion coefficient α, e.g., 23.1 for aluminium.
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Polynomial coefficients The polynomial coefficients are specified in the polynomial on the data sheet (Strain 
gauge data sheet, 87), e.g.:

You must enter as many polynomial coefficients as specified in the polynomial.

If a polynomial coefficient uses exponential representation, e.g., -4.90E-02, type the 
exponential representation and EVIDAS will convert it to decimal.
The polynomial describes the temperature-dependent correction εs.

Leads The effect of temperature on the total electrical resistance is also influenced by the length 
of the lead wires connected to the strain gauge.
The correction factor is specified in the polynomial on the data sheet (Strain gauge data 
sheet, 87), e.g.:

If you use a strain gauge that comes with fixed length lead wires, you must enter the 
specified correction factor.

If you use a strain gauge and cut the existing lead wires, you must enter the specified 
correction factor as well as the length of the leads in millimeters.

 Temperature correction parameters when using temperature reference channel

Parameter Description



86 A04766_01_E00_04 

EVIDAS

k-factor The temperature coefficient of the gauge factor is specified on the data sheet (Strain 
gauge data sheet, 87), e.g.:

Typical temperature coefficients of the gauge factor are 0.01 %/K. Their effect on the 
measurement result is usually very small and therefore ignored.
However, compensation for the temperature-dependency of the gauge factor is possible.

 Temperature correction parameters when using temperature reference channel

Parameter Description
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Strain gauge data sheet

The following data sheet for a strain gauge (quarter bridge) illustrates where 
to find the parameters for temperature correction with a temperature 
reference channel (Temperature correction parameters, 84).

A Thermal expansion parameter α D Polynomial coefficient a1 G Range of error of correction polynomial

B Temperature coefficient of the gauge factor E Polynomial coefficient a2 H Correction factor for fixed length leads

C Polynomial coefficient a0 F Polynomial coefficient a3 I Reference temperature

A

C

B

D E F G H I
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4.1.4 TEDS options

A TEDS sensor has a connector with a built-in TEDS (Transducer Electronic 
Data Sheet) chip that contains the sensor settings.

To display the TEDS options, click the Channels tab, click a project channel, 
and then click TEDS.

The TEDS option assigned to the channel is displayed in dark blue, e.g., 
Activate.

 Configure with TEDS sensor, 61

 TEDS options

Option Description

Activate If the channel has a TEDS sensor, the settings from the TEDS chip are used to 
configure the channel.
Even if you connect the TEDS sensor later, the settings from the TEDS chip will be 
used.
If you select all project channels and assign this option, the settings of the connected 
TEDS sensors will be used to configure the respective channels. Even if you unplug 
a TEDS sensor and plug it into a different channel, EVIDAS will recognize the TEDS 
sensor and activate its settings.
For project channels with this option, on the Project channels panel (Project 
channels panel, 107), you can change the channel name, sample rate, filter, and 
zero value.

If you want to edit other settings, e.g., the calibration date, click Configure and 
then click the following message:

A message indicates that you are editing a TEDS sensor:

To again lock the TEDS sensor, click this message or click Apply to save your 
changes.
The changes are saved on the TEDS chip.

Ignore If the channel has a TEDS sensor, the settings from the TEDS chip are ignored. The 
channel is not configured automatically.
Use this option if you want to use a TEDS sensor with your own settings.

Click Configure to edit any setting (Sensor settings, 79).
The settings are saved in the data acquisition device. The settings on the TEDS chip 
are not affected.
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4.1.5 Sample rate group and domain options

To display, click the Channels tab, and then click the Dialog Box Launcher
of the Sample rate group.

In this dialog box, you define the sample rate domain (Sample rate 
domain, 90) and the sample rate groups (Sample rate groups, 91).
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Sample rate domain

A data acquisition device has one or two basic sample rates, e.g., 
192,000 Hz. The other sample rates available from the device are derived by 
dividing the basic sample rate, e.g., by 2, 4, 5, and 10, leading to sample 
rates such as 96,000 Hz, 48,000 Hz, 38,400 Hz, and 19,200 Hz.

The sample rate domain is a setting applied to data acquisition devices. It 
determines the set of sample rates available for a measuring project.

The sample rate domain selected for a data acquisition device applies to all 
channels of the device.

The data acquisition devices of a measuring project must all use the same 
sample rate domain.

If you have one device that has only the Classic sample rate domain and 
another device that has both sample rate domains, you must use the Classic 
sample rate domain for both.

Changing the sample rate domain, 92

Sample rate domain Description

Classic Available with all HBM data acquisition devices.
The following sample rates are part of this domain:
…, 20, 25, 50, 75, 100, 200, 300, 600, 1,200, 2,400, 4,800, 
9,600, 19,200, 38,400, 48,000, 96,000, and 192,000 Hz.

Decimal Available with some devices only.
The following sample rates are part of this domain:
 …, 20, 50, 100, 200, 500, 600, 1,000, 2,000, 2,500, 5,000, 
10,000, 20,000, 25,000, 50,000, 100,000, and 200,000 Hz.
Devices with a Decimal sample rate domain can be 
switched to the Classic sample rate domain (Changing the 
sample rate domain, 92).
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Sample rate groups

You can define three preferred sample rates for a measuring project. These 
sample rates are referred to as sample rate groups.

To define a sample rate group, in the Sample rate groups dialog box 
(Sample rate group and domain options, 89), select a sample rate from the 
drop-down list.

The available sample rates are determined by the sample rate domain 
(Sample rate domain, 90).

To assign a project channel to a sample rate group, click the Channels tab, 
click a project channel, and then click Slow, Medium, or Fast.

If you change the sample rate of a group, the change applies to all project 
channels assigned to this group.

Not every project channel must be assigned to a sample rate group. You can 
assign sample rates without using a sample rate group (Assigning sample 
rates to project channels, 93). Each project channel can have its own 
sample rate.

Sample rate group Description

Slow Slow sample rate.

Medium Medium sample rate (default).

Fast Fast sample rate.
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4.1.6 Changing the sample rate domain

You can change the sample rate domain of a data acquisition device if the 
device supports both the Classic and Decimal sample rate domains.

To change the sample rate domain

1 Click the Channels tab.

2 In the Sample rate group, click .
 The Sample rate groups dialog box is displayed.

3 Select a sample rate domain.

4 Click OK.
 A dialog box is displayed that asks you to confirm the new sample rate
domain.

5 Click Restart devices.
 The data acquisition device is restarted. Wait until the LEDs on the
device indicate that it is ready.

6 Adjust the sample rate groups and filters to the project.

 Sample rate groups, 91
Filter options, 97
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4.1.7 Assigning sample rates to project channels

The following procedure illustrates your options to assign sample rates to 
project channels.

Prerequisites

 Data acquisition device and sensors are connected.
 Project channels are selected (To select project channels, 59).

You have the following options to assign a sample rate:

Option Description

Automatically On the Options panel (Configuring the sample rate and 
filter of project channels automatically, 100), if you 
selected Configure sample rate and filter automatically, 
new project channels are assigned to the Medium 
sample rate group.
If you did not select automatic channel configuration, the 
sample rate that is stored in the data acquisition device is 
used.

Via sample rate group Assign a project channel to a different sample rate group or 
change the sample rate of a sample rate group (see 
below).

Manually Manually assign a sample rate to a project channel via the 
sample rate drop-down menu. The project channel is no 
longer assigned to a sample rate group (see below).
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To assign sample rates

1 Click the Channels tab.
 The Project channels panel is displayed.

2 On the Channels tab, in the Sample rate group, click .
 The Sample rate groups dialog box is displayed.

3 Change the sample rate of the Medium sample rate group to 600 S/s.

4 Click OK.
 The sample rate of all project channels is changed to 600 S/s.

 On the Options panel (Options panel, 224), if you selected Show 
information about automatically adapted settings, the background of 
the changed settings is highlighed and an  is displayed.
Point to  to display information on the adapted settings.
To clear an info, right-click , and then, on the context menu, click 

Clear all info notifications.
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5 For the first project channel, in the Sample rate column, click , and then 
click 50 S/s.

 The sample rate of the first channel is changed and the channel is no
longer assigned to a sample rate group.

6 For the second project channel, in the Sample rate column, click , and 
then click Delete from group.

 The sample rate of the second channel is unchanged, but the channel
is no longer assigned to the Medium sample rate group.
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7 Change the sample rate of the Medium sample rate group back to 
300 S/s.
 Only the last two channels are affected by the change.

 Sample rate groups, 91
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4.1.8 Filter options

To display, click the Channels tab, click a project channel, and then click 
Filter.

Filters are used to prevent noise (Noise, 98) and aliasing (Aliasing, 99).

The abbreviations, e.g., (Auto), are displayed in the Filter column of the 
Project channels panel.

You want to apply a filter option to several project channels at the same time? 
On the Project channels panel, hold down Ctrl while clicking the channels 
you need, click Filter, and then select a filter option.

Filter option Abbreviation Description

Automatic Anti-Aliasing (Auto) Automatic selection of a low-pass Bessel filter that uses 
about 15% of the sample rate as filter frequency, e.g., a 50 Hz 
Bessel filter for a sample rate of 300 S/s.

Use current device settings (Device filter) If EVIDAS does not configure the sample rate and filter 
automatically (Configuring the sample rate and filter of project 
channels automatically, 100), your last selection is 
remembered by the data acquisition device. The device 
settings are used.

Bypass (Off) No filter is used.
Select - You can select a filter, e.g., a 50 Hz Butterworth filter.
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Noise

Noise is the entirety of random frequencies that disturb the perception of the 
expected signal.

You can eliminate noise with low-pass filters that let frequencies below a 
specified threshold pass and eliminate the frequencies above it.

 Signal with low-pass Bessel filter, 500 Hz

 Signal with low-pass Bessel filter, 50 Hz

 Signal with low-pass Bessel filter, 5 Hz
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Aliasing

An alias is a trace (blue) that does not represent the signal (red) because the 
measured values are too few.

 Aliasing

Theoretically, if a function y(t) contains no frequencies higher than B Hertz, it 
is completely determined by giving its ordinates at a series of points spaced 
1/(2B) seconds apart (Nyquist-Shannon sampling theorem).

For example, a 50 Hz signal is completely determined by measured values 
taken at points spaced 1/100 second apart, i.e., you need a sample rate of 
100 S/s or higher.

HBM recommends to assign a sample rate about ten times the maximum 
frequency that you want to measure, i.e., for a 50 Hz signal to measure with 
300 S/s or 600 S/s.

Also, the Nyquist-Shannon sampling theorem assumes that y(t) contains no 
frequencies higher than B Hertz. You must therefore eliminate with a low-
pass filter any frequencies higher than the maximum frequency that you want 
to measure.

If EVIDAS configures the filter automatically, it uses a filter threshold of about 
15% of the sample rate, e.g., a 50 Hz Bessel filter for a sample rate of 
300 S/s.
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4.1.9 Configuring the sample rate and filter of project channels automatically

You can define that the sample rate and filter of new project channels are 
configured automatically.

To configure the sample rate and filter of project channels automatically

1 Click the File tab.

2 Click Options.

3 Click Data acquisition.

4 In Channel configuration, select the Configure sample rate and filter 
automatically checkbox.

 On the Project channels panel, the sample rate and filter of new 
project channels will be configured automatically.
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4.1.10 Zero balance commands

To display, click the Channels tab, and then click Balance in the Zero 
group.

Before recording, you must zero balance the project channels because the 
measured values from the unloaded sensors are usually different from zero.

To eliminate this offset, you must determine a new zero value for each project 
channel either with a single-point reading or with a multi-point reading with 
averaging (Zero balance options, 103).

The zero value is displayed in the Zero value column and subtracted from 
the measured values.
 Zero balance commands

Command Description

Copy To copy a zero value.

Paste To paste a zero value.

Balance To zero balance a project channel.
While balancing, make sure the sensor is unloaded.
You can define how the zero value is determined (Zero 
balance options, 103).
If you want to zero balance a selection of project channels, 
hold down Ctrl while clicking the project channels you 

need, and then click Balance.

Balance all 
channels

To zero balance all project channels.
Project channels with locked zero values are not affected.
While balancing, make sure the sensors are unloaded.
You can define how the zero value is determined (Zero 
balance options, 103).

Enter zero value 
manually

To enter a zero value manually.
Alternatively, click the cell in the Zero value column, type 
the zero value into the cell, and then press Enter.
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Lock zero value To lock a zero value. A  is displayed.
You cannot zero balance project channels with locked zero 
values.
Use this function to secure the zero values you want to 
keep.
You can use this command together with Balance all 
channels to zero balance a selection of project channels.

Unlock zero value To unlock a zero value.

Clear zero value To clear a zero value, i.e., to reset the zero value to 0.

 Zero balance commands

Command Description
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4.1.11 Zero balance options

To display, click the Channels tab, and then click the Dialog Box Launcher
of the Zero group.

In this dialog box, you define how the zero values are determined.

 Zero balance commands, 101

Option Description

Single-point reading A single measured value from the project channel is taken 
as zero value.

Multi-point reading 
with averaging

The arithmetic mean of a defined number n of measured 
values xi from the project channel is taken as zero value.

Use this option if the signal is slightly unstable.
The number of measured values n used with this option is 
determined by the Averaging over time and the Sample 
rate, e.g., 2 s * 50 S/s = 100 S, i.e.,n = 100.

x 1
n
--- x1 x2 ... xn+ + +( ) 1

n
--- xi

i 1=

n

= =
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4.2 Devices panel

To display, click the Channels tab.

The Devices panel displays the available data acquisition devices.

Search box

The search box enables you to filter the list of data acquisition devices 
(Search box, 47).

Burger menu

To display, click a data acquisition device, and then click .

The options displayed on the burger menu depend on whether you selected a 
channel or a module and on the type of channels you use, e.g., 
CAN channels.

A Search box, 104 C Device icons, 106

B Burger menu, 104 D Channel status icons, 106

 Burger menu commands on Devices panel

Command Description

Blink module LEDs on / off To blink on / off the LEDs on the selected data 
acquisition device to support module 
identification.

Blink channel LED on / off To blink on / off the LED of the selected channel 
to support channel identification.

A B

D
C
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Add device To add a data acquisition device that is not 
recognized automatically, e.g., because the 
device is hidden behind a firewall.
You must specify the IP address of the device, 
e.g.:

Edit CAN Bus settings To edit the settings of the CAN bus, e.g., the bit 
rate.
This command is only displayed for CAN 
channels.

Change connector to analog 
input

To switch the first connector of a QuantumX 
MX840A or MX840B module from CAN mode to 
analog input.
This command is only displayed for CAN 
channels.

Change connector to CAN 
bus

To switch the first connector of a QuantumX 
MX840A or MX840B module from analog input 
to CAN mode, i.e., to have 128 CAN channels 
available (Appendix B: CAN channels, 241).
This command is only displayed for the first 
connector of the mentioned data acquisition 
devices.

Restore factory settings To restore the factory settings of a data 
acquisition device, e.g., when an error occurs 
and you do not know which setting is causing it.

Rename device To edit the name of a data acquisition device.

Change IP settings To bypass the Dynamic Host Configuration 
Protocol (DHCP) that automatically assigns an 
IP address to each data acquisition device.
You must specify an IP address for the device.

Update firmware To update the firmware of the data acquisition 
device.
You must update the firmware if the channel 
status icons turn orange .

Help on devices To access context-sensitive help.

 Burger menu commands on Devices panel

Command Description
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Device icons

Channel status icons

 Appendix B: CAN channels, 241
Appendix C: Digital channels, 253

MGCplus data acquisition device.

PMX data acquisition device.

QuantumX or SomatXR data acquisition device.

Analog channel.

CAN channel.

Digital channel in input mode.

Digital channel in output mode.

Some channels of the data acquisition device are used as project channels.

Channel is not used as project channel.

Channel is used as project channel.

Firmware update is required.
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4.3 Project channels panel

To display, click the Channels tab.

This panel displays all project channels, i.e., the live project channels you 
selected in Devices (Devices panel, 104), and the online calculation 
channels you defined in Online calculations (Online calculations, 111).

Editing options

To edit the settings of a live project channel, use one of the following options:

Sorting

To sort the Project channels table, click a header cell, and then click  to 
sort in normal order or  to sort in reverse order.

A All project channels, 108 E Sensor icons, 231

B Subgroups of project channels, 108 F Sample rate icons, 110

C Burger menu, 108 G Sensor status icons, 110

D Signal status icons, 109

D F G

A B C

E

Option Description

Type Click a cell without  and edit the setting.
Select from drop-down list Click  in a cell and select a setting from the drop-

down list.
Copy / Paste Right-click a cell, click Copy, right-click the target 

cell, and then click Paste.
Fill command Click a cell and point to the right lower corner. A red 

triangle is displayed. Point to the red triangle. When 
the pointer turns into a , drag the pointer to copy 
the setting to other project channels (Configure on 
Project channels panel, 67).
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All project channels

The All tab contains all project channels and displays basic information on 
each channel.

Subgroups of project channels

A subgroup contains project channels with the same sensor type.

Burger menu

Column Description

Channel type The channel type string is composed of the data acquisition 
device type and the channel number on the device, e.g., 
MX440A-1.

Channel name User-defined channel name.
Measured value Live measured value. To change the notation of the 

measured value, right-click the value and select a notation.
Sample rate Number of measured values transferred per second from 

the data acquisition device to EVIDAS (Sample rate group 
and domain options, 89).

Filter Filter option (Filter options, 97).
Sensor / Transducer 
type

Sensor type (Sensors panel, 230).

Zero value Zero value (Zero balance commands, 101).

Command Description

Clear all info notifications To acknowledge and clear an info about a changed project channel setting.
 indicates that EVIDAS or a device has changed a project channel setting.

The background of the changed setting is highlighed.
Info icons  are displayed if the Error handling option is selected (Options 
panel, 224).

Show / hide columns To define which columns are displayed.
If you add a Comment column, any comment typed into this column will be 
displayed after data acquisition with the traceability data (Traceability data, 207) of 
the respective channel.
If you have dragged a column from its default position, click Show / hide 
columns, and then click Reset to default to restore the default order.

Autosize columns To display the full content of all columns.

Blink channel LED on / off To blink on / off the LED of the selected channel to support channel identification.

Help on channel settings To access context-sensitive help.
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Signal status icons

Signal ok.

No signal.

Overflow (Options panel, 224).

A project channel setting has been changed by a device or by EVIDAS.
Point to  for a report. Info icons  are displayed if the Error handling 
option is selected (Options panel, 224).
No connection to data acquisition device.

Error. Point to  for a report.
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Sample rate icons

Sensor status icons

 Project channels panel, 113
Project channels panel in Visualization, 176
Project channels panel in Data manager, 210

Slow sample rate.

Medium sample rate (default).

Fast sample rate.

Settings from database.

Settings have been edited (not saved yet).

Settings from device.

Settings from TEDS sensor.
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5 Online calculations
On the Online calculations tab and its panels, you can define the following 
types of calculation channels:

 Algebra calculation channels (Algebra calculation panel, 116).
 Rosette calculation channels (Rosette calculation panel, 118).

A calculation channel uses a formula to calculate in real time new values from 
values on other channels, e.g., Work W = Force F * displacement s.

Calculation channels are project channels.

A Online calculations tab, 112 C Calculation panel, 115

B Project channels panel, 113

B

A

C
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5.1 Online calculations tab

You can define new calculation channels using various calculation methods.

 Start / Stop button, 40

 Online calculations commands

Group Command Description

Calculation channel Delete To delete a calculation channel.
In Project channels, click the calculation channel you want 
to delete, and then click Delete.

New calculation Algebra To display the Algebra calculation panel (Algebra calculation 
panel, 116).
On the Algebra calculation panel, you can define an algebra 
calculation channel (Defining an algebra calculation 
channel, 122).

 Rosette To display the Rosette calculation panel (Rosette calculation 
panel, 118).
On the Rosette calculation panel, you can define rosette 
calculation channels (Defining rosette calculation 
channels, 123).
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5.2 Project channels panel

To display, click the Online calculations tab.

The Project channels panel displays the live channels you selected as 
project channels and the calculation channels you defined.

Click a calculation channel to display its definition on the Calculation panel 
(Calculation panel, 115).

Click a calculation channel, and then press the Up Arrow key / Down Arrow 
key to subsequently display the definitions of the other calculation channels.

If you edit the definition of a calculation channel, a  is displayed on the 
Project channels panel until you apply the changes by clicking  Apply 
(Calculation panel header, 115).

Folder icons

Calculation channel icons

A Folder icons, 113 D Burger menu, 114

B Calculation channel icons, 113 E Signal status icons, 109

C Search box, 47

Folder with live channels (collapsed).

Folder with live channels (expanded).

Folder with calculation channels.

Algebra calculation channel.

Rosette calculation channel / Group of rosette calculation channels.

C

A

B

D

E
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Burger menu

Command Description

Help on project channels To access context-sensitive help.
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5.3 Calculation panel

On the Calculation panel, you can define the following types of calculation 
channels: 

 Algebra calculation channels (Algebra calculation panel, 116).
 Rosette calculation channels (Rosette calculation panel, 118).

To display the respective calculation panel, click its icon on the Online 
calculations tab, e.g.,  Rosette. 

5.3.1 Calculation panel header

The Calculation panel header is the same for all calculation panels.

The buttons to the left are active, i.e., displayed in blue, if you edit the 
definition of a calculation channel. Otherwise, the buttons are displayed in 
grey, e.g., .

Cancel button

To cancel any changes on the Calculation panel since you last saved the 
definition of the calculation channel.

If you want to define a new calculation channel, click the respective icon on 
the Online calculations tab, e.g.,  Rosette.

Apply button

To save the definition of a calculation channel.

If you defined a new calculation channel, it is now displayed on the Project 
channels panel (Project channels panel, 113).

Burger menu

A Cancel button, 115 C Burger menu, 115

B Apply button, 115

Command Description

Help on online calculations To access context-sensitive help.

A B C
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5.3.2 Algebra calculation panel

To display, click the Online calculations tab, and then click  Algebra.

On the Algebra calculation panel, you can create and edit algebra calculation 
channels, i.e., calculation channels with user-defined formulas.

Channel name

For a new algebra calculation channel, enter a unique name. The default 
names are Formula_1, Formula_2, Formula_3, etc.

Formula

The formula determines how the output values of the algebra calculation 
channel are calculated from the values on its input channels.

The formula must contain at least one live channel or calculation channel as 
input channel.

To insert a channel, drag it from the Project channels panel (Project 
channels panel, 113) to the Formula text box. The channel is represented 
in apostrophes.

A Channel name, 116 C Algebra keyboard, 117

B Formula, 116 D Formula output unit, 117

D

A

B

C
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If you use several input channels, the channels must have the same sample 
rate.

Algebra keyboard

Use the algebra keyboard for support with algebraic expressions, e.g., 
sqrt((‘Channel A’ ^ 2) + (‘Channel B’ ^ 2)).

Place the cursor at the desired position in the formula, and then click the 
respective button to insert a number, an operator, or a function.

Formula output unit

Use this combo box to specify the output unit of the algebra calculation 
channel.

 Defining an algebra calculation channel, 122
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5.3.3 Rosette calculation panel

To display, click the Online calculations tab, and then click  Rosette.

On the Rosette calculation panel, you can create and edit rosette calculation 
channels. The rosette formulas are predefined.

A Name prefix, 119 D Material properties, 120

B Type of rosette, 119 E Results, 121

C Source channels, 120 F Transverse sensitivity correction, 121

C

E

F

D

A

B
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Name prefix

For each rosette, enter a unique name. The default names are Rosette_1, 
Rosette_2, Rosette_3, etc. 

This name is then used as group name for a set of rosette calculations, e.g., 
Rosette_1, and as prefix for the rosette calculations included in the group, 
e.g., Rosette_1_PrincipalStress1.

If you select Use ‘Channel a’ prefix = , the channel name specified in 
Channel a is used as rosette name and prefix.

If you select Use ‘Channel a’ prefix = , Autocomplete = , and 
Rosettes > 1, the channel name specified in Channel a of each rosette is 
used as rosette name and prefix for the respective rosette (Source 
channels, 120).

Type of rosette

Select the type of rosette you use.

The drop-down list includes general types of rosettes, e.g., 0°/45°/90 a-b-c, 
as well as specific HBM rosettes, e.g., HBM RY1 series.

The diagram to the right displays the type of rosette you selected.
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Source channels

In Channel a, Channel b, and Channel c, you assign the project channels 
that correspond to the strain gauges on the rosette.

You have the following options to assign project channels to rosettes:

For T-rosettes, you assign two project channels, one to Channel a and one to 
Channel b.

A project channel can only be assigned to a rosette if its sensor is a strain 
gauge.

If you autocomplete several rosettes, you can check the project channels 
assigned to each rosette after clicking  Apply.

Material properties

Type in Young’s modulus E and Poisson’s ratio ν for the material to which the 
rosette is attached to.

 Options for assigning project channels to rosettes

Option Autocomplete 
toggle switch

Rosettes 
spin box Description

Assign manually 1 Select the project channels from the 
Channel a, Channel b, and 
Channel c drop-down lists.
Alternatively, assign the project 
channels via drag-and-drop from the 
Project channels panel.

Autocomplete 
one rosette

1 Assign the project channel with the 
signal from strain gauge a on the 
rosette to Channel a.
The next two project channels on 
the Project channels panel are 
filled in automatically to Channel b 
and Channel c.

Autocomplete 
several rosettes

n Assign the project channel with the 
signal from strain gauge a on the 
first rosette to Channel a.
The next two project channels on 
the Project channels panel are 
filled in automatically to Channel b 
and Channel c.
Also, the next (n-1)*3 project 
channels on the Project channels 
panel are filled in automatically for 
the next n-1 rosettes.
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Results

List of available rosette calculations.

Select  to include the respective rosette calculation, select  to 
exclude it.

Once you click  Apply, for each rosette calculation you selected, one 
rosette calculation channel is created .

Transverse sensitivity correction

The transverse sensitivity parameters specify for each strain gauge on the 
rosette a percentage as correction for the angular deviation of the strain 
gauge in relation to the exact intended angle.

To take into account this angular deviation, enter the transverse sensitivity 
parameters from the rosette data sheet, e.g.:

 Defining rosette calculation channels, 123

A Transverse sensitivity parameters on a rosette data sheet

A
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5.4 Defining calculation channels

 Defining an algebra calculation channel, 122
 Defining rosette calculation channels, 123

5.4.1 Defining an algebra calculation channel

Prerequisites

 Data acquisition device and sensors are connected.
 Project channels are selected (To select project channels, 59).

To define a calculation channel

1 Click the Online calculations tab, and then click  Algebra.

2 In Name, type a name for the new calculation channel. 

3 In Unit, select the output unit of the formula.

4 In Formula, enter the formula that calculates the output values.
 The formula must contain at least one live channel or calculation 
channel as input channel.
 To insert an input channel, drag it from the Project channels panel into 
the Formula text box.
 Use the algebra keyboard for support with algebraic expressions 
(Algebra keyboard, 117).
 If you use several input channels, make sure the channels have the 
same sample rate (Formula, 116).

5 Click  Apply.
 The formula is saved and the new algebra calculation channel is
displayed on the Project channels panel.
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5.4.2 Defining rosette calculation channels

Prerequisites

 Data acquisition device and rosette are connected.
 Rosette channels are selected as project channels (To select project

channels, 59).

To define rosette calculation channels

1 Click the Online calculations tab, and then click  Rosette.
 To minimize your work when defining new rosette calculation channels, 
on the Project channels panel, click a similar rosette calculation channel 
in order to display its definition on the Calculation panel. Then click  
Rosette. The definition of the previous rosette is kept on the Calculation 
panel, except for the name prefix and the source channels.

2 In Name prefix, enter a name for the group of rosette calculations. 
 This name is also used as prefix for the rosette calculation channels, 
e.g., Rosette_1_PrincipalStress1.
 If you want to use the name of Channel a instead, select Use ‘Channel 
a’ prefix = .

3 In Type of rosette, select the type of rosette you use, e.g., 0°/45°/90° 
a-b-c.

4 In Channel a, Channel b, and Channel c, assign the project channels that 
correspond to the strain gauges on the rosette.
 If you want to manually assign the project channels, select 
Autocomplete = , and then select the project channels from the 
Channel a, Channel b, and Channel c drop-down lists. Alternatively, 
assign the project channels via drag-and-drop from the Project channels 
panel.
 If the rosette project channels are listed subsequently on the Project 
channels panel, you can autocomplete all but the first source channel:
Select Autocomplete =  and in Rosettes the number of rosettes you 
want to create calculation channels for, e.g., 3, and then, in Channel a, 
assign the project channel with the signal from strain gauge a on the first 
rosette.
The project channels for the first rosette and all subsequent rosettes are 
filled in automatically (Source channels, 120).

5 In Young’s modulus E and Poisson’s ratio ν, type in the respective 
physical constants of the material to which the rosette is attached.

6 Under Results, select  to include a rosette calculation, or  to 
exclude it.

7 In Grid a, Grid b, and Grid c, enter the transverse sensitivity parameters 
of the rosette from the rosette data sheet (Transverse sensitivity 
correction, 121).
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8 Click  Apply.
 A group of rosette calculation channels is created and displayed on the
Project channels panel.
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6 Acquisition
On the Acquisition tab and its panels, you define the following:

 Start and stop conditions of a recording.
 Location where the measured values are stored.
 Optionally, a connection to an IoT platform to which measured values of

selected project channels are streamed at defined intervals.

Burger menu

A Recording options, 126 C Monitoring options, 141

B Data file options, 136 D Burger menu, 125

A B C D

Command Description

Help on recording To access context-sensitive help.

Help on data file To access context-sensitive help.

Help on monitoring To access context-sensitive help.
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6.1 Recording options

To display, click the Acquisition tab, and then click the Recording tab.

On the Recording tab, you define how the recording is started and stopped, 
whether it is repeated, and whether the channels are zero-balanced before 
each recording.

A time line visualizes the start / stop events you defined and the composition 
of the total recording time.

A Start options, 127 E Zero-balance option, 133

B Trigger options, 129 F Device lost behavior, 134

C Stop options, 128 G Time line, 134

D Repeat recording options, 133

A

G

DC EB F
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6.1.1 Start options

To display, click the Acquisition tab, and then click the Recording tab.

Start options define how the recording is started.

 Time line icons, 135

Option Description

At acquisition start To manually start recording by clicking Start.

On trigger To automatically start recording as soon as a trigger 
condition is fulfilled (Trigger options, 129).

You must still click Start to start monitoring the trigger 
channel until the trigger condition is fulfilled.
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6.1.2 Stop options

To display, click the Acquisition tab, and then click the Recording tab.

Stop options define how the recording is stopped.

 Time line icons, 135

Option Description

At acquisition end To manually stop recording by clicking Stop.

On trigger To automatically stop recording as soon as a trigger 
condition is fulfilled (Trigger options, 129).

After specified 
duration

To stop recording after a specified time.
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6.1.3 Trigger options

To display, click the Acquisition tab, and then click the Recording tab.

You can define start and stop triggers.

If you define a trigger to start or stop recording, EVIDAS monitors the trigger 
channel and checks whether the trigger condition is fulfilled.

Once the trigger condition is fulfilled, EVIDAS starts or, respectively, stops 
recording on all project channels.
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Trigger option Mode Description

Channel The channel to be monitored to check whether the trigger 
condition is fulfilled.

Mode Above level Recording is started as soon as a measured value Y ≥ trigger 
level L (Trigger modes, 131).

Below level Recording is started as soon as a measured value Y ≤ trigger 
level L (Trigger modes, 131).

Rising edge Recording is started if the measured values have been below 
the trigger level L for some time and then a measured value 
Y ≥ L (Trigger modes, 131).

Falling edge Recording is started if the measured values have been above 
the trigger level L for some time and then a measured value 
Y ≤ L (Trigger modes, 131).

Level In the Level box, you define the trigger level L.

Pre-Trigger To define a time period in which data is already recorded prior 
to the start trigger condition being fulfilled.

This option is displayed if you specify a start trigger (Start 
options, 127).

Post-Trigger To define a time period in which data is recorded after the 
stop trigger condition has been fulfilled.

This option is displayed if you specify a stop trigger (Stop 
options, 128).
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Trigger modes

To display, click the Acquisition tab, and then click the Recording tab.

The trigger mode and trigger level L (Trigger options, 129) define an event 
on the trigger channel that starts or stops recording on all project channels. 

The following table displays how trigger modes affect the start of the 
recording. To stop recording, the trigger modes work analogously.

 Trigger modes

Trigger mode Description Illustration

Above level If you click Start and the 
first measured value Y ≥ L, 
recording is started 
immediately.

If the measured values are 
below L initially, recording is 
started as soon as a 
measured value Y ≥ L.

If the measured values are 
continously below L, 
recording is not started.
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 Time line icons, 135

Rising edge If the measured values are 
below L for some time and 
then a measured value Y ≥ L, 
recording is started.

Below level If you click Start and the 
first measured value Y ≤ L, 
recording is started 
immediately.

If the measured values are 
above L initially, recording is 
started as soon as a 
measured value Y ≤ L.

If the measured values are 
continously above L, 
recording is not started.

Falling edge If the measured values are 
above L for some time and 
then a measured value Y ≤ L, 
recording is started.

 Trigger modes

Trigger mode Description Illustration
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6.1.4 Repeat recording options

To display, click the Acquisition tab, and then click the Recording tab.

The Repeat recording options are active if the recording stops automatically, 
i.e., either after a specified duration, or when a stop trigger condition is
fullfilled.

Each recording is stored in a separate EVIDAS data file (*.pnrf) and optionally 
in other formats as well (File formats, 139).

6.1.5 Zero-balance option

To display, click the Acquisition tab, and then click the Recording tab.

 Zero balance commands, 101
Zero balance options, 103

Option Description

Don’t repeat The recording is performed once and is not repeated.
Repeat The recording is performed once and is then repeated 

n times.

You can stop recording at any time by clicking  Stop.

Until data acquisition 
is stopped manually

The recording is performed once and is then repeated 
endlessly until data acquisition is stopped by clicking 

Stop.

Pause Delay between repeated recordings.

Option Description

Zero-balance 
hardware channels

The project channels are zero-balanced automatically 
before each recording.
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6.1.6 Device lost behavior

To display, click the Acquisition tab, and then click the Recording tab.

6.1.7 Time line

To display, click the Acquisition tab, and then click the Recording tab.

Example 1: Time line with triggers

The time line visualizes the start / stop events you defined and the 
composition of the total recording time.

Option Description

Continue with data 
acquisition of all 
other channels

Data acquisition continues for all active channels even if 
communication with one or more devices is lost.

A Pre-trigger recording time D Stop trigger

B Start trigger E Post-trigger recording time

C Main recording time F Total recording time

A

F

B EC D
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Example 2: Time line with repeated recordings

In addition to the time line of the recording, the delay between recordings and 
the number of repetitions are displayed.

Time line icons

A Start of recording D Delay between recordings

B Specified duration of recording E Number of repetitions

C Stop of recording

Recording is started manually by clicking Start.

For repeated recordings,  also indicates the start of a repeated 
recording.
Recording is started / stopped automatically with a trigger condition 
(Trigger options, 129).
Recording is stopped after a specified duration.

Recording is stopped manually by clicking Stop.

Recording is repeated automatically, e.g., 4 times.

Recording is repeated endlessly until data acquisition is stopped 

manually by clicking Stop.

A

E

B C D
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6.2 Data file options

To display, click the Acquisition tab, and then click the Data file tab.

On the Data file tab, you define where the measured values are stored.

You can save data in several file formats simultanously and add metadata to 
each file.

6.2.1 Data default folder and file name

To display, click the Acquisition tab, and then click the Data file tab.

A Data default folder and file name, 136 D File formats, 139

B Storage options, 138 E Metadata, 140

C Cloud storage, 138

A

D EB C
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After recording, if you want to save the data without further confirmation 
(Storage options, 138), you can define a default folder and file names for 
the data files.

Option Description

Folder You can define a default folder for data files, e.g.:

If you do not define a default folder, EVIDAS uses the 
following default:

After recording, you can access the data files in the 
Project data folder in Data manager (File 

browser, 205).

Name In the filename, you can include counters and date / time 
information via placeholders.

Placeholder Placeholders make sure that each recording has a unique 
filename, e.g., Test_%cc% generates Test_01, Test_02, 
Test_03, etc. for subsequent recordings.

If you do not insert a placeholder, EVIDAS inserts a counter 
automatically, e.g., Test, Test(2), Test(3), etc.
To insert a placeholder, click on a position in the filename, 
e.g., at the end, select a placeholder from the Placeholder
drop-down list, and then click Insert.

You can also use placeholders in the folder name, e.g., to 
automatically generate a new default folder on the first, 
second, third, etc. day of measuring.

Preview Displays the default folder, the filename, and an example 
string for the placeholders you inserted, e.g.:
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6.2.2 Storage options

To display, click the Acquisition tab, and then click the Data file tab.

6.2.3 Cloud storage

To display, click the Acquisition tab, and then click the Data file tab.

You can select this option if the HBM cloud is activated (Activating the HBM 
cloud, 23).

Option Description

Prompt when 
recording has 
finished

At the end of recording, a dialog box is displayed. You must 
decide whether to save the data or not. If you want to save 
the data, you must specify a folder and a filename.

Save without 
confirmation

The data files are stored in the default folder for data files 
without further notice or confirmation (Data default folder 
and file name, 136).

Don’t save The data files are not saved.

Option Description

Save a copy of the 
data file in the cloud

At the end of each recording, a copy of the *.pnrf data file is 
uploaded to the HBM cloud (HBM cloud, 208).
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6.2.4 File formats

To display, click the Acquisition tab, and then click the Data file tab.

All measured values are saved in the EVIDAS data file format *.pnrf (Primary 
Native Recording Format).

In addition, you can select other file formats. The measured values are then 
saved simultanously in the selected formats.

Click  to add a file format to the list, e.g., ASCII (*.txt), Excel (*.xlsx), or 
MATLAB (*.mat).

Click  to remove a file format from the list.
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6.2.5 Metadata

To display, click the Acquisition tab, and then click the Data file tab.

The metadata is recorded in all subsequent data files and is displayed in the 
Data manager (Traceability data, 207).

Data type Description

Comment To add information not specified under Test information.

Test information To define test information, e.g., the device under test 
(DUT), the manufacturer, and the operator.

For each item, you must define a name, a value, and a 
position in the list.
Click  to add an item to the list.
Click  to remove the selected item from the list.
Click  to move up a selected item in the list.
Click  to move down a selected item in the list.
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6.3 Monitoring options

To display, click the Acquisition tab, and then click the Monitoring tab.

On the Monitoring tab, you can set up a data streaming connection between 
EVIDAS and an IoT platform in the cloud, e.g., to monitor a road bridge.

EVIDAS supports data streaming to different IoT platforms, e.g., to Microsoft 
Power BI.

Prerequisites

Before setting up EVIDAS for data streaming, you must do the following:

 Open an account on the IoT platform.
 Decide which project channels you want to stream.
 On your IoT account, create a streaming dataset and specify the exact

names of the project channels you want to stream.
 Copy the Push URL provided by the IoT platform when creating the

streaming dataset.
 On your IoT account, create a dashboard. The dashboard defines how

the streaming dataset is displayed.

For detailed information how to set up a streaming dataset and a dashboard, 
please refer to the respective HBM Tech Notes on www.hbm.com.

A Setup options, 142 C Channel selection, 144

B Endpoint specifications, 143

A

B C
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6.3.1 Setup options

To display, click the Acquisition tab, and then click the Monitoring tab.

In Setup you define the update rate and the IoT platform you are connecting 
to. 

Option Description

Monitoring Select this checkbox if you want to stream data to an IoT 
platform.

Update rate The update rate is the interval at which measured values 
from selected project channels (Channel selection, 144) 
are streamed to the IoT platform.
The update rate is normally less than 1 Hz in order not to 
exceed the data streaming volume.

Connection From the drop-down list, select the IoT platform.
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6.3.2 Endpoint specifications

To display, click the Acquisition tab, and then click the Monitoring tab.

An endpoint defines the web address where the data is streamed to.

In addition, some IoT platforms request that you specify the username and 
password of your IoT account, as well as an SSL certificate.

For detailed information how to specify the endpoint that connects EVIDAS to 
the IoT platform, please refer to the respective HBM Tech Notes on 
www.hbm.com.

Option Description

Device ID Enter the device ID you specified when creating the 
streaming dataset on your IoT account.
Specifying a device ID prevents measured values from 
different devices being mixed in the same streaming 
dataset.

URL Paste the Push URL provided by the IoT platform when you 
created the streaming dataset.
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6.3.3 Channel selection

To display, click the Acquisition tab, and then click the Monitoring tab.

In Select channels you define the project channels that are streamed to the 
IoT platform.

The channel names specified in the streaming dataset on the IoT platform 
must be identical with the project channel names in EVIDAS.

To add a channel to the list, select a project channel from the drop-down list, 
and then click Add.

To remove a channel from the list, select the channel, and then click .
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7 Visualization
On the Visualization tab and its panels, you define how the project channels 
are visualized.

Project channels can be live project channels, live calculation channels, or 
review channels.

To visualize a channel, click a visualization object in the Insert group, e.g., 
y(t), and then drag a channel from Project channels to the visualization 

object (Visualizing signals in a y(t) chart, 179).

To configure a visualization object, click the object, and then define its design 
and content on the contextual tab set displayed on the ribbon (Contextual 
tabs for visualization objects, 150).

If you do not define any visualization objects, EVIDAS will automatically 
visualize the first four active project channels in y(t) charts, digital meters, and 
a data table as soon as you click Start.

For examples on working with visualization objects, see: Working with 
visualization objects, 179.

A Visualization tab, 146 C Visualization panel, 177

B Project channels panel in Visualization, 176

B C

A
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7.1 Visualization tab

On the Visualization tab, you select the visualization objects for your project 
channels, e.g., a y(t) chart. The visualization objects are displayed on the 
visualization panel (Visualization panel, 177).

7.2 Visualization commands

A Visualization commands, 146 B Contextual tabs for visualization objects, 150

A B

 Visualization commands

Group Command Description

Panel Add To add a panel, e.g., to display visualization objects on 
another screen.
To configure the new panel, see: Contextual tab for 
visualization panels, 175.

Delete To delete a panel. You can only delete a panel if at least one 
other panel remains.
Click the panel you want to delete, and then click Delete.

Full screen To switch all visualization panels to full screen.
The Acquisition control panel is displayed (Status 
panel, 41).

To exit full screen mode, click  on the header of the 
visualization panel or press Esc.

Zoom Zoom To zoom in on all visualization objects on the active panel by 
10% per click.
The zoom factor is displayed.

Zoom out To zoom out on all visualization objects on the active panel by 
10% per click.
The zoom factor is displayed.
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Insert y(t) To insert a y(t) chart on the visualization panel (Visualizing 
signals in a y(t) chart, 179).
To assign a channel to a y(t) chart, drag the channel from 
Project channels to the y-axis of the y(t) chart.
To configure the y(t) chart, see: Contextual tabs for 
y(t) charts, 151.

X-Y To insert an X-Y chart on the visualization panel (Visualizing 
signals in an X-Y chart, 182).
To assign channels to an X-Y chart, drag them from Project 
channels to the y-axis and to the x-axis of the X-Y chart.
To configure the X-Y chart, see: Contextual tabs for X-
Y charts, 156

FFT To insert an FFT chart on the visualization panel (Visualizing 
the frequency spectrum of a signal in an FFT chart, 186).
To assign a channel to an FFT chart, drag the channel from 
Project channels to the y-axis of the FFT chart.
To configure the FFT chart, see: Contextual tabs for 
FFT charts, 161

Digital To insert a digital meter on the visualization panel.
To assign a channel to a digital meter, drag the channel from 
Project channels to the digital meter.
To configure the digital meter, see: Contextual tab for digital 
meters, 169.

Table To insert a data table on the visualization panel.
To assign a channel to a data table, drag the channel from 
Project channels to the table.
To configure the data table, see: Contextual tab for data 
tables, 171.

Text To insert a text box on the visualization panel.
To configure the text box, see: Contextual tab for text 
boxes, 173

 Visualization commands

Group Command Description
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Chart tools Zoom out To zoom out one zoom step at a time in the selected 
y(t) chart.

Zoom reset To zoom out all prior zoom steps at once in the selected 
y(t) chart.

R-zoom To zoom in on any rectangular section of the selected 
y(t) chart.

To zoom, click R-zoom, click in the trace area, and hold
down the pointer. When the pointer turns into a , drag the 
pointer to select a rectangular section, and then release the 
pointer (Zooming a trace, 193).

H-zoom To zoom in horizontally, i.e., on a time window of the selected 
y(t) chart.

To zoom, click H-zoom, click in the trace area, and hold
down the pointer. When the pointer turns into a , drag the 
pointer to select a time window, and then release the pointer 
(Zooming a trace, 193).

 Visualization commands

Group Command Description
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 Start / Stop button, 40
Freeze button, 40

Live To display all traces in the selected y(t) chart in real time 
within a defined time window (Design tab for 
y(t) charts, 152), e.g., within the last 10 seconds.
The trace is moved from right to left through the time window.
You can switch from Live mode to Overview mode 
and back during the measurement.

Overview To display an overview of all traces in the selected y(t) chart 
since the start of the measurement.
The y(t) chart keeps its size and the trace is compressed 
each time after a defined time increment (Design tab for 
y(t) charts, 152).
You can switch from Overview mode to Live mode 
and back during the measurement.

Cursor To display information on measured values in a 
y(t) chart.

You can drag the cursors to the measured values you want to 
investigate.
For the second measured value, the difference Δ to the first 
value is displayed.

Edit Delete To delete the selected visualization object.

Copy To copy the selected visualization object to the clipboard.

Paste To paste the content of the clipboard to the selected 
visualization panel.

Report Print To print the content of the selected visualization panel to the 
default printer.

Portrait To select portrait printing.

Landscape To select landscape printing.

 Visualization commands

Group Command Description
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7.3 Contextual tabs for visualization objects 

On the contextual tabs (Contextual tabs, 43) you define the design and 
content of the visualization objects.

The contextual tabs are displayed if a visualization object is selected, e.g., a 
y(t) chart.

The contextual tabs disappear if you click away from the visualization panel.

A Contextual tabs for y(t) charts, 151 E Contextual tab for data tables, 171

B Contextual tabs for X-Y charts, 156 F Contextual tab for text boxes, 173

C Contextual tabs for FFT charts, 161 G Contextual tab for visualization panels, 175

D Contextual tab for digital meters, 169

D E

A

GF

B

C
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7.3.1 Contextual tabs for y(t) charts

To display, click the Visualization tab, and then click y(t), or click a 
y(t) chart on the visualization panel.

A y(t) chart visualizes measured values over time.

To assign a channel to a y(t) chart, drag a live or review channel from the 
Project channels panel to the y(t) chart (Visualizing signals in a 
y(t) chart, 179).

A Design tab for y(t) charts, 152 C Content tab for y(t) charts, 155

B Y-axes tab for y(t) charts, 154

A B C
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Design tab for y(t) charts

On the Design tab for y(t) charts, you define the title, the number and 
arrangement of y-axes, the time settings, the background colors, and the 
position of the legend.

 Commands on the Design tab for y(t) charts

Group Command Description

Title Text To enter the title of the y(t) chart.

Font To select the font and font size of the title.

To define the title color, select a color from the color palette.

Bold.

Italic.

Align left.

Center.

Align right.

Y-axes Y-axes To define the number of coordinate systems in the y(t) chart 
(Visualizing signals in a y(t) chart, 179).

Layered To display the coordinate systems layered, i.e., one on top of 
the other. The scales of the y-axes are all displayed to the 
left. The traces are displayed on top of each other.

Stacked To display the coordinate systems stacked. The traces are 
displayed separately.

Dual For layered systems, to display the scales of the y-axes to the 
left and to the right.
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X-Axis Time unit To define the time unit on the x-axis, e.g., seconds [s].

Time window To define the time window displayed on the y(t) chart.
This option is available in Live mode (Visualization 
commands, 146).

Time increment To define the time after which the display of the x-axis and of 
the trace is updated to fit the expanding time window in 

Overview mode (Visualization commands, 146).
Color Frame To define the background color outside the coordinate 

system.

Graph To define the background color of the coordinate system.

Legend Position To define the position of the legend. The legend is displayed 
outside the trace area.

Hide legend To hide or display the legend.

 Commands on the Design tab for y(t) charts

Group Command Description
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Y-axes tab for y(t) charts

On the Y-axes tab for y(t) charts, you define the scaling of the y-axes.

 Commands on the Y-axes tab for y(t) charts

Group Command Description

Current selection Axis To select a y-axis. Alternatively, click a legend in the 
y(t) chart.

General Text To edit the name of the y-axis.

Notation To define the notation of the scale values on the y-axis.

To define the scale color of the y-axis, select a color from the 
color palette.

Scaling type Auto To use autoscaling. The scaling on the y-axis is adjusted 
automatically to the signal range.

Manual To manually define the scaling range on the y-axis.
You must define a minimum and maximum value in the Scale 
values group.

From sensor To apply the scaling range defined in the sensor settings 
(Sensor settings, 79).

Scale values Max To define the maximum scale value on the y-axis.

Min To define the minimum scale value on the y-axis.

Grid lines Horizontal To define the number of horizontal grid lines in the trace area.

Hide grid lines To hide or display the horizontal grid lines.
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Content tab for y(t) charts

On the Content tab for y(t) charts, you assign traces to coordinate systems 
and define how the traces are displayed.

 Commands on the Content tab for y(t) charts

Group Command Description

Current selection Trace To select a trace for editing. Alternatively, click a legend in the 
y(t) chart.

Color To define the trace color, select a color from the color palette.

Axes Y-axis To select the coordinate system in which the trace is 
displayed.

Line style Type To define the line style of the trace, e.g., a dashed line 
(Changing the line style of a trace, 196).

Marker To define the markers used for the measured values 
(Changing the line style of a trace, 196).

Width To define the line width of the trace (Changing the line style of 
a trace, 196).

Trace Delete To delete a trace from the y(t) chart (Deleting a trace, 192).
Alternatively, right-click the legend of the trace, and then click 

Delete trace from chart.
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7.3.2 Contextual tabs for X-Y charts

To display, click the Visualization tab, and then click X-Y, or click an
X-Y chart on the visualization panel.

X-Y charts are used to visualize the relationship between two signals. One
signal is assigned to the x-axis, the other to the y-axis. The signal on the
x-axis is called the X-channel, the signal on the y-axis is the Y-channel.

Example 1: Force-displacement diagram to determine mechanical work.

Example 2: Pressure-volume diagram to examine the efficiency of an engine 
cycle.

Example 3: Lissajous curves. These traces are generated by a sinewave 
each on the X-channel and on the Y-channel. The frequency ratio (a fraction 
with an integer numerator and denominator) and phase shift of the sinewaves 
determine the form of the Lissajous curve.

 A Lissajous curve on an X-Y chart

To assign channels to an X-Y chart, drag the live or review channels from the 
Project channels panel to the respective axes on the X-Y chart (Visualizing 
signals in an X-Y chart, 182).

A Design tab for X-Y charts, 157 C Content tab for X-Y charts, 160

B Axes tab for X-Y charts, 159

A B C
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Design tab for X-Y charts

On the Design tab for X-Y charts, you define the title, the number and 
arrangement of y-axes, the background colors, the position of the legend, 
and the number of horizontal and vertical grid lines.

 Commands on the Design tab for X-Y charts

Group Command Description

Title Text To enter the title of the X-Y chart.

Font To select the font and font size of the title.

To define the title color, select a color from the color palette.

Bold.

Italic.

Align left.

Center.

Align right.

Axes Y-axes To define the number of y-axes on the X-Y chart.
You can assign different project channels to the y-axes, but 
only one project channel to the x-axis.
The coordinate systems are layered, i.e., they are displayed 
one on top of the other.
Click Dual to display the scales of the y-axes on both 
sides of the layered coordinate systems.

Time window To define a time window for the X-Y chart.
Measured values that are older than the time window, e.g., 
older than 10 seconds, are not displayed when the display of 
the chart is refreshed.

Dual To display the scales of the y-axes to the left and to the right.

Color Frame To define the background color outside the coordinate 
system.

Graph To define the background color of the coordinate system.
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Legend Position To define the position of the legend. The legend is displayed 
outside the trace area.

Hide legend To hide or display the legend.

Grid lines Horizontal To define the number of horizontal grid lines in the trace area.

Vertical To define the number of vertical grid lines in the trace area.

Hide grid lines To hide or display the grid lines.

 Commands on the Design tab for X-Y charts

Group Command Description
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Axes tab for X-Y charts

On the Axes tab for X-Y charts, you define the scaling of the axes.

 Commands on the Axes tab for X-Y charts

Group Command Description

Current selection Axis To select an axis. This can be a y-axis or the x-axis.

General Text To enter the name of the axis.

Notation To define the notation of the scale values on the axis.

To define the scale color, select a color from the color palette.

Scaling type Auto To use autoscaling. The scaling on the axis is adjusted 
automatically to the signal range.

Manual To manually define the scaling range.
You must define a minimum and a maximum value in the 
Scale values group.

Logarithmic To use logarithmic scaling on the selected axis.

Scale values Max To define the maximum scale value on the axis.

Min To define the minimum scale value on the axis.
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Content tab for X-Y charts

On the Content tab for X-Y charts, you assign traces to coordinate systems 
and define how the traces are displayed.

 Commands on the Content tab for X-Y charts

Group Command Description

Current selection Trace To select a trace. Alternatively, click a legend on the 
X-Y chart.

Color To define the trace color, select a color from the color palette.

Channels and axes Y-channel The Y-channel of the selected trace is displayed.

Y-axis The y-axis of the Y-channel is displayed.
To assign the selected trace to another coordinate system, 
select a different y-axis.

X-channel The X-channel of the selected trace is displayed.

X-axis All traces use the same x-axis.

Line style Type To define the line style of the trace, e.g., a dashed line 
(Changing the line style of a trace, 196).

Marker To define the markers used for the measured values 
(Changing the line style of a trace, 196).

Width To define the line width of the trace (Changing the line style of 
a trace, 196).

Trace Delete To delete a trace from the X-Y chart (Deleting a trace, 192).
Alternatively, right-click the legend of the trace, and then click 

Delete trace from chart.
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7.3.3 Contextual tabs for FFT charts

To display, click the Visualization tab, and then click FFT, or click an 
FFT chart on the visualization panel.

An FFT chart visualizes the frequency components of a signal. The 
amplitudes of the frequency components represent their respective 
contribution to the signal (Appendix D: FFT Introduction, 257).

 An FFT representation of a signal with a main frequency component of 5 Hz

To assign a channel to an FFT chart, drag a live or review channel from the 
Project channels panel to the y-axis of the FFT chart (Visualizing the 
frequency spectrum of a signal in an FFT chart, 186).

A Design tab for FFT charts, 162 C Content tab for FFT charts, 166

B Axes tab for FFT charts, 164 D FFT settings tab, 167

A B C D
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Design tab for FFT charts

On the Design tab for FFT charts, you define the title, the number and 
arrangement of y-axes, the background colors, the position of the legend, 
and whether the peak markers are displayed.

 Commands on the Design tab for FFT charts

Group Command Description

Title Text To edit the title of the FFT chart.

Font To select the font and font size of the title.

To define the title color, select a color from the color palette.

Bold.

Italic.

Align left.

Center.

Align right.

Y-axes Y-axes To define the number of coordinate systems on the 
FFT chart.

Layered To display the coordinate systems layered, i.e., one on top of 
the other. The scales of the y-axes are all displayed to the 
left. The traces are displayed on top of each other.

Stacked To display the coordinate systems stacked. The traces are 
displayed separately.

Dual For layered systems, to display the scales of the y-axes to the 
left and to the right.

Color Frame To define the background color outside the coordinate 
system.

Graph To define the background color of the coordinate system.
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Legend Position To define the position of the legend. The legend is displayed 
outside the trace area.

Hide legend To hide or display the legend.

Peak Show To display or hide the peak markers.

 Commands on the Design tab for FFT charts

Group Command Description
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Axes tab for FFT charts

On the Axes tab for FFT charts, you define the scaling of the axes.

 Commands on the Axes tab for FFT charts

Group Command Description

Current selection Axis To select an axis. This can be a y-axis or the frequency axis.

General Text To edit the name of a y-axis (The name of the x-axis is always 
Frequency).

Notation To define the notation of the scale values on the axis.

Show To define the unit of a y-axis either as the physical unit of the 
project channel or as decibel [dB]. For the x-axis the unit is 
Hz.
To define the scale color of the axis, select a color from the 
color palette.

Scaling type Auto To use autoscaling. The scaling on the axis is adjusted 
automatically to the signal range.

Manual To manually define the scaling range.
You must define a minimum and maximum value in the Scale 
values group.

Logarithmic To use logarithmic scaling on the selected axis. Use 
logarithmic scaling to fit a vast spectrum of frequencies or 
amplitudes into the chart (Visualizing the frequency spectrum 
of a signal in an FFT chart, 186).

Scale values Max To define the maximum scale value on the y-axis.

Min To define the minimum scale value on the y-axis.

Max To define the maximum scale value on the x-axis.

Min To define the minimum scale value on the x-axis.
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Grid lines Horizontal This icon is displayed if you select a y-axis.
Use this icon to define the number of horizontal grid lines in 
the trace area.
If you use logarithmic scaling on the y-axis, the number of 
horizontal grid lines is defined by the program.

Vertical This icon is displayed if you select the x-axis.
Use this icon to define the number of vertical grid lines in the 
trace area.
If you use logarithmic scaling on the x-axis, the number of 
vertical grid lines is defined by the program.

Hide grid lines To hide or display the grid lines.

 Commands on the Axes tab for FFT charts

Group Command Description
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Content tab for FFT charts

On the Content tab for FFT charts, you assign traces to coordinate systems 
and define how the traces are displayed.

 Commands on the Content tab for FFT charts

Group Command Description

Current selection Trace To select a trace. Alternatively, click a legend on the 
FFT chart.

Color To define the trace color, select a color from the color palette.

Axes Y-axis To select the coordinate system in which the trace is 
displayed.

Line style Type To define the line style of the trace, e.g., a dashed line 
(Changing the line style of a trace, 196).

Marker To define the markers used for the measured values 
(Changing the line style of a trace, 196).

Width To define the line width of the trace (Changing the line style of 
a trace, 196).

Trace Delete To delete a trace from the FFT chart (Deleting a trace, 192).
Alternatively, right-click the legend of the trace, and then click 

Delete trace from chart.
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FFT settings tab

On the FFT settings tab, you define the following settings:

 Frequency analysis option.
 Window function.
 Block settings.
 Averaging algorithm.

A Dialog Box Launcher to display list of block settings (List of block settings, 168)

A

 Commands on the FFT settings tab

Group Command Description

Analysis Analysis/output To select a frequency analysis option (Frequency analysis 
options, 268).

Window To select a window function for minimizing spectral leakage 
(Windowing, 264).

Block Resolution To select the frequency resolution Δf (Frequency 
resolution Δf, 260).
If the sample rate fs and the frequency resolution Δf are 
given, the number of lines L and the block size N are 
determined (Dependencies between block settings, 262).

Lines To select the number of lines L (Number of lines L, 261).
If the sample rate fs and the number of lines L are given, the 
frequency resolution Δf and the block size N are determined 
(Dependencies between block settings, 262).

Size N To select the block size N (Block size N, 259).
The larger the block size N, the longer the FFT calculation 
will take and the more accurate the frequency peaks will be 
displayed on the FFT chart.
If the sample rate fs and the block size N are given, the 
frequency resolution Δf and the number of lines L are 
determined (Dependencies between block settings, 262).

Sample rate The sample rate fs of the project channel is displayed 
(Sample rate fs, 259).
You cannot change the sample rate in the frequency domain.
If there is more than one project channel assigned to the 
FFT chart and those project channels use different sample 
rates, the sample rate of the first project channel assigned to 
the FFT chart is taken for the FFT calculation.
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List of block settings

To display, on the FFT settings tab, click the Dialog Box Launcher  of the 
Block group.

The block settings of the project channels that are assigned to the FFT chart 
are displayed (Block settings, 259).

Frequency span The frequency span F is displayed (Frequency 
span F, 261).
The frequency span F is determined by the sample rate fs 
(Dependencies between block settings, 262).

Duration The block duration T is displayed (Block duration T, 260).
With the sample rate fs fixed, the block duration T is 
determined by the block size N (Dependencies between 
block settings, 262).

Average Type To select an averaging algorithm (Averaging, 267).

Period To select the time period in seconds for which the 
FFT calculations are averaged.

 Commands on the FFT settings tab

Group Command Description
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7.3.4 Contextual tab for digital meters

To display, click the Visualization tab, and then click Digital or a digital 
meter on the visualization panel.

To assign a channel to a digital meter, drag a live or review channel from the 
Project channels panel to the digital meter.

A digital meter shows the digital representation of the measured values for a 
single project channel.

By default, the current value is displayed. Alternatively, you can display the 
minimum value, maximum value, mean value, or standard deviation since the 
start of the measurement.
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Meter Setup tab

On the Meter Setup tab, you define the design of the digital meter, the 
notation of the measured values, the update rate, and the type of value 
displayed.

 Start / Stop button, 40
Freeze button, 40

 Commands on the Meter Setup tab

Group Command Description

Design Border color To define a color for the border of the digital meter.

Border width To define a line width for the border of the digital meter.

Transparent To make the digital meter transparent, i.e, only the title of the 
digital meter and the measured values are displayed. The 
border and background color definitions are inactive.

General Notation To define the notation of the measured values.

Unit To define the position of the physical unit.

Updates To define the update rate per second.

Title Name To enter a title for the digital meter.

Font To define the font and font size of the title.

Background color To define a background color for the title.

To define the position of the title.

To define the title color.

Value Source To assign a project channel to the digital meter and to select 
the type of value displayed.
By default, the current value is displayed. Alternatively, you 
can display the minimum value, maximum value, mean value, 
or standard deviation since the start of the measurement.

Font To define a font and font size for the measured values.

Background color To define a background color for the measured values.

To define a color for the measured values.

To align the measured values on the meter.
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7.3.5 Contextual tab for data tables

To display, click the Visualization tab, and then click Table or a table on 
the visualization panel.

To assign a channel to a data table, drag a live or review channel from the 
Project channels panel to the data table.

A data table displays the measured values and basic statistical parameters 
for one or more project channels.

You can select the statistical parameters displayed in the data table.

The parameters are calculated over all measured values since the start of the 
measurement.
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Table Setup tab

On the Table Setup tab, you define the design of the table header, the 
content of the columns, and the notation of the measured values.

 Start / Stop button, 40
Freeze button, 40

 Commands on the Table Setup tab

Group Command Description

Design Font To define a font and font size for the table header.

Columns Minimum To display the minimum value since the start of the 
measurement.

Time of minimum To display the time at which the minimum value occured.

Maximum To display the maximum value since the start of the 
measurement.

Time of maximum To display the time at which the maximum value occured.

Actual To display the current value.

Mean To display the mean value of all measured values since the 
start of the measurement.

STD To display the standard deviation of all measured values 
since the start of the measurement.

General Notation To define the notation of the measured values.
Click the drop-down menu button  and select a notation.



A04766_01_E00_04 173

EVIDAS

7.3.6 Contextual tab for text boxes

To display, click the Visualization tab, and then click Text or a text box 
on the visualization panel.

You can insert a text box, e.g., to create a header for a data table.

You cannot assign a channel to a text box.
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Text Setup tab

On the Text Setup tab, you define the design of the text box, its content and 
how the text is formated.

You can move the text box on the visualization panel and adjust its size.

 Start / Stop button, 40
Freeze button, 40

 Commands on the Text Setup tab

Group Command Description

Design Border color To define a color for the border of the text box.

Border width To define a line width for the border of the text box.

Background color To define a background color for the text box.

Transparent To make the text box transparent, i.e, only the text and the 
border of the text box are displayed. The background color is 
inactive.

Text Text To enter text into the text box.

Font To select a font and font size for the text.

To define the color of the text.

Bold.

Italic.

Align left.

Center.

Align right.
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7.3.7 Contextual tab for visualization panels

To display, click the Visualization tab, and then click the visualization panel, 
but not any visualization object.

Panel Setup tab

On the Panel Setup tab, you can edit the panel name, change the 
background color, and define a snap grid.

 Start / Stop button, 40
Freeze button, 40
Visualization panel, 177

 Commands on the Panel Setup tab

Group Command Description

Panel Name To edit the panel name.

Background color To define a background color for the panel, select a color from 
the color palette.

Grid Spacing To define the spacing of the snap grid.

The snap grid supports the alignment of visualization objects 
on the panel.

Show To show / hide the snap grid.

Snap To activate / deactivate the snap grid.
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7.4 Project channels panel in Visualization

To display, click the Visualization tab.

The Project channels panel displays the live and review channels available 
for visualization.

Live channels

A live channel delivers measured values from a sensor or calculated values.

Review channels

A review channel delivers measured values from a file.

Burger menu

A Live channels, 176 D Burger menu, 176

B Review channels, 176 E Folder icons, 113

C Search box, 47 F Signal status icons, 109

Command Description

Help on project channels To access context-sensitive help.

C

E

BA D

E
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7.5 Visualization panel

To display, click the Visualization tab.

The visualization panel displays the visualization objects you defined, e.g., a 
y(t) chart.

Panel tab

You can define more than one visualization panel, e.g., to display 
visualization objects on a second screen.

To display a panel, click the respective Panel tab.

To move a panel to another screen, click the Panel tab, hold down the 
pointer, and then drag it to the other screen.

Add panel button

To add a visualization panel, click .

Burger menu

A Panel tab, 177 C Burger menu, 177

B Add panel button, 177 D Full screen button, 178

A DB C

Command Description

Help on visualization To access context-sensitive help.
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 Full screen button

To maximize the visualization panel, click . The status panel turns into a 
floating panel (Status panel, 41).

To exit full screen mode, click  or press Esc.
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7.6 Working with visualization objects

The following procedures demonstrate how to work with visualization objects.

Prerequisites

 Data acquisition device and sensors are connected.
 Project channels are selected (To select project channels, 59).
 Project channels are configured (Configuring project channels, 60).

7.6.1 Visualizing signals in a y(t) chart

A y(t) chart visualizes measured values over time.

To visualize signals in a y(t) chart

1 Click the Visualization tab.

2 Click y(t).
 An empty y(t) chart is displayed.

 On the ribbon, the contextual tab set for y(t) charts is displayed 
(Contextual tabs for y(t) charts, 151).

A Frame C y-axis (with scale for measured values)

B Trace area D x-axis (with time scale in [s])

B

C

A

D
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 Alternatively, drag a project channel to an empty space on the 
visualization panel and, on the context menu, click Insert y(t) chart.
A y(t) chart is displayed and the project channel is assigned to the y-axis.
However, for the rest of this procedure, it is assumed that you start with an 
empty y(t) chart.

3 Drag a live project channel or review channel to the chart, and when the 
pointer turns into a , release the pointer to assign the project channel to 
the y-axis.

 In dual coordinate systems (Design tab for y(t) charts, 152), if you 
move the pointer towards the right y-axis, the pointer turns into a . 
Release the pointer to assign the project channel to the right y-axis.
 The y-axis is labeled and a legend is displayed.

4 Click the Design tab and select Y-axes = 2.
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 A second coordinate system is displayed.

 You can display the coordinate systems stacked (see above) or 
layered. For layered systems, you can display the scales of the y-axes 
either all to the left, or to the left and to the right (dual) (Design tab for 
y(t) charts, 152).

5 Drag a project channel to the empty coordinate system.
 Both y-axes are labeled and a legend for each coordinate system is
displayed.

6 Click Start.
 Both signals are displayed.

 Contextual tabs for y(t) charts, 151
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7.6.2 Visualizing signals in an X-Y chart

An X-Y chart visualizes the relationship between two signals. One signal is 
assigned to the x-axis, the other to the y-axis. The signal on the x-axis is 
called the X-channel, the signal on the y-axis is the Y-channel.

To visualize signals in an X-Y chart

1 Click the Visualization tab.

2 Click X-Y.
 An empty X-Y chart is displayed.

 On the ribbon, the contextual tab set for X-Y charts is displayed 
(Contextual tabs for X-Y charts, 156).

 Alternatively, drag a project channel to an empty space on the 
visualization panel and, on the context menu, click Insert X-Y chart.
An X-Y chart is displayed and the project channel is assigned to the y-axis.
However, for the rest of this procedure, it is assumed that you start with an 
empty X-Y chart.

A Frame C y-axis (with scale for Y-channel)

B Trace area D x-axis (with scale for X-channel)

B

C

A

D
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3 Drag a project channel to the y-axis of the chart.

 When the pointer turns into a , release the pointer to assign the 
project channel to the y-axis.
 The y-axis is labeled and the first half of the legend is displayed.
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4 Drag a project channel to the x-axis of the chart.

 When the pointer turns into a , release the pointer to assign the 
project channel to the x-axis.
 The x-axis is labeled and the full legend is displayed.
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5 Click Start.
 The X-Y trace is displayed.

 Contextual tabs for X-Y charts, 156
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7.6.3 Visualizing the frequency spectrum of a signal in an FFT chart

An FFT chart visualizes the frequency components of a signal. The 
amplitudes of the frequency components represent their respective 
contribution to the signal (Appendix D: FFT Introduction, 257).

To visualize the frequency spectrum of a signal in an FFT chart

1 Click the Visualization tab.

2 Click FFT.
 An empty FFT chart is displayed.

 On the ribbon, the contextual tab set for FFT charts is displayed 
(Contextual tabs for FFT charts, 161).

 Alternatively, drag a project channel to an empty space on the 
visualization panel and, on the context menu, click Insert FFT chart.
An FFT chart is displayed and the project channel is assigned to the chart.
However, for the rest of this procedure, it is assumed that you start with an 
empty FFT chart.

A Frame C y-axis (amplitude)

B Trace area D x-axis (frequency in [Hz])

B

C

A

D
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3 Click the Axes tab, select Axis = X-axis, and then click 
Logarithmic.

 The scaling of the x-axis is changed to logarithmic.

4 Drag a project channel to the FFT chart.

 When the pointer turns into a , release the pointer to assign the 
project channel to the FFT chart.
 The y-axis is labeled and a legend is displayed.

 On the y-axis, you can display the amplitude of the signal either in its 
physical unit, e.g., in Newton [N], or in decibel [dB] (Axes tab for 
FFT charts, 164).



188 A04766_01_E00_04 

EVIDAS

5 Click Start.
 The frequency spectrum of the signal is displayed.

 Contextual tabs for FFT charts, 161
Appendix D: FFT Introduction, 257
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7.6.4 Moving or copying a visualization object and changing its size

You can move a visualization object to any position on the visualization panel, 
you can copy the object, e.g., to another panel, and you can change the size 
of the object.

To move or copy a visualization object and to change its size

1 Click the Visualization tab.

2 Insert a visualization object, e.g., a y(t) chart (Visualizing signals in a 
y(t) chart, 179).
 The visualization object is displayed.

 The grey frame indicates that the visualization object is active. The 
contextual tabs of the visualization object are displayed on the ribbon 
(Contextual tabs for visualization objects, 150).

A Grey frame B Handle

A

B
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3 Point to the grey frame. When the pointer turns into a , drag the pointer 
to move the visualization object.

4 Point to one of the handles. When the pointer turns into a , drag the 
pointer to change the size of the visualization object.



A04766_01_E00_04 191

EVIDAS

5 Right-click the visualization object and, on the context menu, click 
Copy.

 The visualization object is copied to a buffer.

6 On the visualization panel header, click  (Add panel button, 177).

 A new visualization panel and its tab are displayed.

7 Right-click the new visualization panel and, on the context menu, click 
Paste.

 The visualization object is copied to the new panel.

 Visualization commands, 146
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7.6.5 Deleting a trace

You can delete traces from any chart.

To delete a trace

1 Click a chart, e.g., a y(t) chart.
 A grey frame is displayed.

2 On the Content tab, select a trace, and then click Delete.

 The trace is removed from the chart.

 Alternatively, right-click the legend of the trace, and then click Delete 
trace from chart.
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7.6.6 Zooming a trace

You can zoom a section of a trace.

To zoom a trace

1 On the Visualization tab, click H-zoom.

 The horizontal zoom tool is activated (Visualization commands, 146).

2 Click a chart, e.g., a y(t) chart.
 A grey frame is displayed.

3 On the chart, click into the trace area and hold down the pointer. When the 
pointer turns into a , drag the pointer to select a zoom window.

4 Release the pointer.
 The section is zoomed.

5 Click Zoom out to restore the previous view.
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7.6.7 Scrolling a trace

You can scroll a trace horizontally or vertically.

To scroll a trace

1 Point to the x-axis, e.g., of a y(t) chart.
 The pointer turns into a .

2 Drag the pointer to the left or right.
 The trace is scrolled horizontally.
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3 Point to the y-axis 
 The pointer turns into a .

4 Drag the pointer up or down.
 The trace is scrolled vertically.
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7.6.8 Changing the line style of a trace

The following procedure shows how you can change the line style of a trace.

To change the line style of a trace

1 Click a chart, e.g., a y(t) chart.
 A grey frame is displayed.

2 On the Content tab, select the following options:
a) Type = Dash.
b) Width = 2.

 The trace is displayed dashed and bold.
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3 Or select the following options:
a) Type = None.
b) Marker = Triangle.

 The markers representing the measured values are displayed.

 If you cannot see the markers, zoom the trace (Zooming a trace, 193).
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7.6.9 Working on several visualization objects at the same time

You can select several visualization objects in order to work on them at the 
same time.

If you select visualization objects of different types, e.g., a y(t) chart and a 
digitial meter, you can move, copy, or delete them together.

If the selected visualization objects are of the same type, e.g., two digital 
meters, you can change many of their design features together, e.g., the 
design of the title, borders, and values displayed. However, you cannot 
change content features of several visualization objects together.

To work on several visualization objects at the same time

1 Click the Visualization tab.

2 Click Digital twice and drag the digital meters next to each other.

3 Assign a project channel to each digital meter and click Start.

4 Hold down Ctrl while clicking each of the two digital meters.
 A grey frame is displayed for each digital meter.

 Alternatively, point away from the digital meters, drag a frame across 
them, and then release the pointer.

 The visualization objects are selected even if the frame overlaps only 
partially.



A04766_01_E00_04 199

EVIDAS

5 On the Meter contextual tab, click Setup.

 The Setup tab for digital meters is displayed.

 Settings that are displayed active (not grey) can be edited for both 
digital meters at the same time.

6 Experiment with the settings.
 The respective features are changed for both digital meters at once.

7 To move several visualization objects together, select them, point to one of 
the grey frames, and then drag the objects to the desired location.
 The selected objects are moved to the new location.

8 To copy and paste several visualization objects together, select them, 
right-click them, select Copy from the context menu, right-click 
somewhere else on the same or on another visualization panel, and then 
select Paste on the context menu.
 A copy of the selected objects is inserted.

9 To delete several visualization objects together, select them, right-click 
them, and then select Delete … and confirm the delete command.
 The selected objects are deleted.

 Contextual tab for digital meters, 169
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8 Data manager
On the Data manager tab and its panels, you can do the following:

 Browse folders (File browser, 205).
 Browse data files (Traceability data, 207).
 Define favorite folders (Folder list, 206).
 Open folder in Explorer (Opening a folder in Explorer, 208).
 Upload data files to HBM cloud (HBM cloud, 208).
 Select channels for review (Project channels panel in Data

manager, 210).
 Export channels to various file formats (Export channels panel, 211).

Review channels

To select a channel for review, drag it from the File browser to the Project 
channels panel. The channel is now available as a review channel in 
Visualization (Visualization, 145).

You can display a review channel and a live signal in the same y(t) chart 
(Comparing a live signal with a previous test, 212).

A Data manager tab, 203 D Project channels panel in Data manager, 210

B File browser, 205 E Export channels panel, 211

C HBM cloud, 208

A

B D EC
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Export channels

To export a channel, drag it from the File browser to the Export channels 
panel, select an export format, e.g., Excel, and then click Export.

During export, all channels on the Export channels panel are merged into 
one export file.

Therefore, you can use the export function to merge channels from different 
files into one file (Merging channels from different files, 216).
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8.1 Data manager tab

 Data manager commands

Group Command Description

Files Expand all To display the channels of each file in the File browser.

Collapse all To hide all channels displayed in the File browser.

Delete To delete a file in the File browser.
Click the file you want to delete, and then click Delete.

Upload To upload a file to the HBM cloud.
In the File browser, click the file you want to upload, and 

then click Upload.
The file is uploaded to the HBM cloud (HBM cloud, 208).

Download To download a file from the HBM cloud.

In the File browser, click HBM cloud, click the file you 

want to download, and then click Download.
The file is downloaded to the Project data folder (Data 
default folder and file name, 136).

Project channels Add To copy a file from the File browser to the Project channels 
panel (Project channels panel in Data manager, 210).
Click the file or channel you want to review, and then click 

Add.
Alternatively, you can drag the file or channel to the Project 
channels panel.

Delete To delete a channel or file from the Project channels panel.
On the Project channels panel, click the channel or file you 
want to delete, and then click Delete.

Export channels Add To copy a file from the File browser to the Export channels 
panel (Export channels panel, 211).
Click the file or channel you want to export, and then click 

Add.
Alternatively, you can drag the file or channel to the Export 
channels panel.
You can only export data files that are in the EVIDAS data file 
format (*.pnrf).

Delete To delete a channel or file from the Export channels panel.
On the Export channels panel, click the channel or file you 
want to delete, and then click Delete.
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 Start / Stop button, 40

Export Format To select an export format, e.g., EVIDAS (*.pnrf) or MATLAB 
(*.mat).

Export To export all channels on the Export channels panel to a file 
in the selected export format (Export channels panel, 211).

 Data manager commands

Group Command Description
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8.2 File browser

To display, click the Data manager tab.

In the File browser, you can select a folder in the folder list (E) to display its 
files in the file list (H). In the file list you can filter by name (C) and extension, 
i.e., by file format (B). Click a file to display metadata on the recording (G).

Double-click a file to display its channels. You can drag channels to the 
Project channels panel to select them as review channels (Project channels 
panel in Data manager, 210).

You can also drag channels to the Export channels panel for export (Export 
channels panel, 211).

Click a channel to display its traceability data (I), i.e., the sensor settings, 
some basic statistical data on the recording, and an optional comment from 
the Project channels panel (Project channels panel, 107) regarding the 
channel.

Path

This box displays the full pathname of the folder selected in the folder list (E).

The files of the selected folder are displayed in the file list (H).

A Path, 205 F HBM cloud, 208

B Format filter, 206 G Recording information, 206

C Filename filter, 206 H File list, 206

D Burger menu, 206 I Traceability data, 207

E Folder list, 206

A B C D

E
H

G I

F
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Format filter

You can filter the file list by extension, e.g., to display catman data files (*.bin) 
in the selected folder.

Filename filter

You can filter the file list for a string in the filename, e.g., to display all files 
recorded on a specific date if you used placeholders to insert the date into the 
filenames.

Burger menu

Folder list

In the folder list, you select a folder to view its files.

The default folder for data files is the Project data folder in Favorites. 
The default folder is defined in Acquisition (Data default folder and file 
name, 136).

You can define your own favorite folders:

 To add a folder to Favorites, right-click the folder in the folder list, and
then click Add to favorites.

 To remove a folder from Favorites, right-click the folder in
Favorites, and then click Remove from favorites.

File list

The file list displays the files in the selected folder that meet the filter criteria 
(Filename filter, 206 , Format filter, 206).

Filenames in grey indicate that those files cannot be selected for review or 
export.

Use the following arrow keys to display traceability data on files and 
channels:

Recording information

In this area, the filename and metadata on the recording are displayed, e.g., 
the number of channels and the sample rate.

Command Description

Open folder in Explorer To open the selected folder in the Explorer (Opening 
a folder in Explorer, 208).

Help on file browser To access context-sensitive help.

Arrow key Function

Up / Down To display information on either the files or the 
channels.

Left / Right To display information on both the files and their 
channels.
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Traceability data

The information displayed in this area depends on whether you select a file or 
channel.

 Sensor settings and basic statistical data on a strain gauge recording (example)

Selection in file list Content

File The user-defined test information and comment are 
displayed. This information is defined on the Data 
file tab (Metadata, 140).

Channel The sensor settings and some basic statistical data 
on the measured values are displayed.
If you added a Comment column on the Project 
channels panel (Burger menu, 108), any 
comment typed into this column is displayed with 
the traceability data of the respective channel.
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8.3 Opening a folder in Explorer

To supplement the functionality of the Data manager (Data manager, 201), 
you can open a folder in the Explorer, e.g., to rename, move, or copy data 
files.

To open a folder in Explorer

1 Click the Data manager tab.

2 In the File browser, right-click a folder or file, and then click Open 
folder in Explorer.
 All files of the current folder are displayed in the Explorer.

8.4 HBM cloud

To display, click the Data manager tab.

The HBM cloud provides external storage capacity for EVIDAS data files 
(*.pnrf ). You can also upload catman data files (*.bin).

HBM cloud activation

By default, the HBM cloud is deactivated. To activate the HBM cloud, see: 
Activating the HBM cloud, 23.

HBM cloud features

Each EVIDAS license includes 5 GB of cloud storage capacity. Please 
contact HBM if you need more (Manufacturer, 4).

You can use the HBM cloud to backup EVIDAS data files (*.pnrf) and to share 
them with colleagues or customers (HBM cloud storage website, 209).

Your data is protected from loss through copies at a redundant cloud storage 
location of the cloud hosting provider.

The test information (Metadata, 140) and traceability data (Traceability 
data, 207) of the EVIDAS data files in the cloud are displayed in the File 
browser in the same way as for EVIDAS data files on your computer or 
network.
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HBM cloud upload options

HBM cloud storage website

Once your data files are uploaded to the HBM cloud, you can access them 
via any web browser on https://storage.hbm-solutions.com (Internet 
Explorer not supported).

To access data files on the HBM cloud storage website, you, or any person 
you want to share data with, will need your email address and cloud 
password.

A temporary password is mailed to your email address when activating the 
HBM cloud (Activating the HBM cloud, 23).

The HBM cloud storage website provides the following services:

 Display of total cloud storage capacity.
 Display of remaining cloud storage capacity.
 Display of cloud storage location, e.g., West Europe.
 List of data files.
 List of project channels for each data file.
 Data file download.

Option Description

Manual upload Click a file in the File browser, and then click 

Upload (Data manager tab, 203).
Automatic upload Select the Cloud storage option (Cloud 

storage, 138).
A copy of each new EVIDAS data file is uploaded to 
the HBM cloud.
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8.5 Project channels panel in Data manager

To display, click the Data manager tab.

Review channels

To select a channel for review, drag it from the File browser (File 
browser, 205) to the Project channels panel.

If required, the data file is converted to EVIDAS format (*.pnrf) (File 
formats, 139). For example, if you drag a catman data file (*.bin) to the 
Project channels panel, the file is converted to *.bin.pnrf.

The channels on the Project channels panel are now available as review 
channels in Visualization (Visualization, 145)

You can display a review channel and a live signal in the same y(t) chart 
(Comparing a live signal with a previous test, 212).

Burger menu

Folder icons

Channel icons

A Review channels, 210 D Folder icons, 210

B Search box, 47 E Channel icons, 210

C Burger menu, 210

Command Description

Help on review channels To access context-sensitive help.

Channels folder (collapsed).

Channels folder (expanded).

Analog channel.

CAN channel.

Digital channel.

B

D

CA

E
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8.6 Export channels panel

To display, click the Data manager tab.

Export channels

To export a channel, drag it from the File browser (File browser, 205) to the 
Export channels panel, select an export format, e.g., Excel, and then click 

Export.

You can also drag a review channel from the Project channels panels to the 
Export channels panel, select an export format, and then click Export.

During export, all channels on the Export channels panel are merged into 
one export file.

You can only export data files that are in the EVIDAS data file format (*.pnrf) 
(File formats, 139). If you want to export a file of a different format, e.g., a 
catman data file (*.bin), drag it from the File browser to the Project 
channels panel. The data file is converted to EVIDAS data file format (*.pnrf). 
On the Project channels panel, right-click the file, and then click Add to 
export channels.

You can use the export function to merge channels from different files into 
one file in EVIDAS data file format (Merging channels from different 
files, 216).

Burger menu

A Export channels, 211 D Folder icons, 210

B Search box, 47 E Channel icons, 210

C Burger menu, 211

Command Description

Help on export channels To access context-sensitive help.

B

D

CA

E
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8.7 Comparing a live signal with a previous test

In a y(t) chart, you can use a channel from a previous test as reference 
channel for a live signal.

Prerequisites

 Data acquisition device and sensors are connected.
 EVIDAS is started.

To compare a live signal with a previous test

1 Click the Data manager tab.

2 In the File browser, drag the channel from the previous test to the Project 
channels panel.

 The channel is available as review channel.

3 Click the Visualization tab.

4 On the Project channels panel, click the Review tab.
 The review channel you selected is displayed.

5 Click y(t).
 An empty chart is displayed.
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6 Drag the review channel to the y(t) chart.
 The review channel is displayed in overview mode.

7 Click the y(t) chart.
 The contextual tab set is displayed.

8 Click the Design tab and select Y-axes = 2.
 A second coordinate system is displayed.
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9 On the Project channels panel, click the Live tab and drag the live project 
channel to the second coordinate system.
 The legend of the channel is displayed.
 Alternatively to steps 7 to 9, drag the live project channel to the very left 
side of the y-axis until the pointer becomes a , and then release the 
pointer. A second coordinate system is displayed and the live project 
channel is assigned to it.

10 Click Start.
 The live project channel is displayed below the reference channel.
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 To display the traces in the same coordinate system, delete the trace in 
the second coordinate system (Deleting a trace, 192), drag the live 
project channel to the first coordinate system, and on the the Design tab 
select Y-axes = 1. 
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8.8 Merging channels from different files

On the Data manager tab, you can use the Export command to merge 
channels from different files into one file.

Prerequisites

 Data acquisition device and sensors are connected.
 EVIDAS is started.
 Several tests have been recorded.

To merge channels from different files

1 Click the Data manager tab.

2 In the File browser, drag the channels you want to merge to the Export 
channels panel.

 The channels are selected for export.
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3 In the Export group, select EVIDAS (*.pnrf) as export format, and then 
click Export and enter a filename.

 The export file is written. It contains the channels from the Export
channels panel.
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9 File
On the File menu and its panels, you can do the following:

 Activate your EVIDAS license (Info panel, 222).
 Activate the HBM cloud (Info panel, 222).
 Renew your EVIDAS license (Info panel, 222).
 Borrow a network license if you are registered for such (Info

panel, 222).
 Get help on using EVIDAS (Info panel, 222).
 Administrate EVIDAS projects (File menu, 220).
 Select user options, e.g., the language of the EVIDAS user interface

(Options panel, 224).

A File menu, 220 B Info panel, 222

A B
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9.1 File menu

To display, click the File tab.
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 Options on the File menu

Option Description

To return to the ribbon (Ribbon, 39).

Info To activate your EVIDAS license, to activate the HBM 
cloud, to borrow a network license if you are registered for 
such, to renew your EVIDAS license, and to get assistance 
on using EVIDAS (Info panel, 222).
The release number and license information are displayed.

New To start a new project (*.evidas) (Starting a new 
project, 58).
You must save the current project before starting a new 
one. Otherwise, the settings of the current project are lost, 
e.g., the project channels, recording options, and
visualization objects you defined.

Open To open an existing project (*.evidas) (Opening a 
project, 71). You can select a recent project file or 
navigate to a project file.
The project channels and settings are loaded from the 
project file.
If EVIDAS detects that a data acquisition device required 
for this project is not connected to the system, a hardware 
mapper is displayed (Hardware mapper, 72).
The default folder for project files is 
C:\Users\Public\Documents\HBM\EVIDAS\Projects.

Save To save the current project (Saving a project, 70).
Save as To save the current project under a different name.
Options To select user options, e.g., the language of the EVIDAS 

user interface (Options panel, 224).
Exit To exit EVIDAS.
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9.2 Info panel

To display, click the File tab.

A Info groups B Content of info groups

BA
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 Infos and buttons on the Info panel

Info group Info section / Button Description

About EVIDAS Release and licence 
information

The release number and license information are displayed.
The license type defines which product features are enabled:
Viewer - You can use EVIDAS as a free viewer for data files.
Trial - You can test a full version of EVIDAS for 30 days.
Single - You have installed and activated a full EVIDAS 
single license.
Network - You are registered for using an EVIDAS network 
license.
This button is displayed if your license type is Viewer or Trial.
Click this button to display the EVIDAS activation dialog box 
in order to activate an EVIDAS single or network license: 
Activating EVIDAS, 12
This button is displayed of your license type is Single or 
Network.
Click this button to display the License manager dialog box 
in order to perform one of the following tasks:
Renewing an EVIDAS license, 34
Borrowing an EVIDAS network license, 37
This button is enabled if you have activated your license.
Click this button to activate the HBM cloud:
Activating the HBM cloud, 23

Assistance Click this button to display the EVIDAS online help.
The online help contains a full description of EVIDAS:
Online help, 28
Click this button to open a PDF help file.
The PDF help file contains a full description of EVIDAS.

Click this button to contact the HBM support team.
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9.3 Options panel

To display, click the File tab, and then click Options.

A Groups of options B Options

A B
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 Options for configuring EVIDAS

Group of options Option Description

Program start Project selection To define what EVIDAS is supposed to do when being 
started.

You have the following options:
1. EVIDAS starts a new project from scratch.
2. EVIDAS starts a new project and loads all channels of all
detected data acquisition devices as project channels.
3. EVIDAS loads a project file, (optionally) waits a specified
time for hardware availability, and (optionally) starts data
acquisition.

Data acquisition Data acquisition stopped To add the project channels to the list of review channels after 
completing data acquisition.

Overflow replacement An overflow value is a value that cannot be measured 
because it is outside the measuring range of the data 
acquisition device.

A signal in overflow is handled as follows:
1. On the data acquisition device, the channel LED turns red.
2. On the Project channels panel, the overflow icon  is
displayed (Signal status icons, 109) and in the Measured
value column, the message text Overflow is displayed.
3. In the EVIDAS data file, instead of physical values, the
user-defined Overflow replacement value is recorded.

Make sure the Overflow replacement value is large enough 
to not interfere with the measuring range of the data 
acquisition device. The Overflow replacement value helps 
you to identify when a signal was in overflow, e.g., after 
exporting data into a different format.
4. On the Visualization panel, the message text Overflow is
displayed on the digital meter and in the Actual column of the
data table.

Channel configuration To define whether the sample rate and filter are configured 
automatically when adding a new project channel 
(Configuring the sample rate and filter of project channels 
automatically, 100).
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User interface Application language To define the language of the user interface.
You must restart the application before this change takes 
effect.

Reset options A. To redisplay hidden dialog boxes.
B. To restore the factory settings of the software.

Error handling To alert you that a project channel setting has been changed
either by a device or by EVIDAS.

On the Project channels panel, the info icon is displayed 
and the setting is highlighted.

Point to  for a report.
To acknowledge a changed setting and to delete , on the 

burger menu of the Project channels panel, click Clear 
all info notifications (Burger menu, 108).

 Options for configuring EVIDAS

Group of options Option Description
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10 Appendix A: Sensor manager
To display, click the Channels tab, and then click Manage.

On the Sensor manager tab and its panels, you can copy HBM sensors to 
the user-defined sensor database and edit their settings there.

A Sensor manager tab, 228 C Sensor editor, 234

B Sensors panel, 230 D Scaling type, 238

B

A

DC
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10.1 Sensor manager tab

To display, click the Channels tab, and then click Manage.

Most commands on the Sensor manager tab apply to the user-defined 
sensor database.

 Sensor manager commands

Group Command Description

User database Open To open a user-defined sensor database.

Import To import sensors or a CAN database (Importing a CAN 
database, 245).
The settings are imported into the Imported sensor group 
of the user-defined sensor database. 

Export To export sensors from the user-defined sensor database.
On the Sensors panel, hold down Ctrl while you click the 
sensors you want to export, and then click Export.

Save As To save a user-defined sensor database.

Group Add To add a new sensor group to the user-defined sensor 
database (Tree view, 49).
On the Sensors panel, click the sensor group into which you 

want to insert the new sensor group, and then click Add.

Delete To delete a sensor group.
On the Sensors panel, click the sensor group you want to 
delete, and then click Delete.
The sensor group and its sensors are moved to the 

Deleted sensor group.
To recover a sensor group, click it in the Deleted sensor 

group and drag it to Sensor groups.

Collapse all To collapse the tree view on the Sensors panel (Tree 
view, 49).

Expand all To expand all sensor groups on the Sensors panel (Tree 
view, 49).
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Sensor Add To add a new sensor to the user-defined database.
On the Sensors panel, click the user-defined sensor group in 

which you want to insert the new sensor, click Add, and 
then click a sensor type and sensor.
The new sensor contains only basic settings and must be 
configured.

Delete To delete a user-defined sensor.
On the Sensors panel, hold down Ctrl while you click the 
sensors you want to delete, and then click Delete.
The sensors are moved to the Deleted sensor group.
To recover a sensor, click it in the Deleted sensor group 
and drag it to a sensor group.

Duplicate To copy a sensor.
On the Sensors panel, click the user-defined sensor that you 
want to copy, and then click Duplicate.
The sensor settings are copied to the new sensor.

Copy sensor to user 
database

To copy sensors from the HBM sensor database to the user-
defined sensor database.
On the Sensors panel, right-click an HBM sensor, and then 
click Copy sensor to user database.
The sensor is copied to the Imported sensor group of the 
user-defined sensor database.

Sensor manager Return to Channels To return to the Channels tab.

 Sensor manager commands

Group Command Description
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10.2 Sensors panel

To display, click the Channels tab, and then click Manage.

HBM sensor database

The HBM sensor database contains all available HBM sensors with their 
default settings. The database is updated with each release of the software.

You cannot edit any settings in the HBM sensor database.

To edit the settings of an HBM sensor, e.g., to match its settings to the 
specifications on the sensor data sheet, you must copy the HBM sensor to 
the user-defined sensor database and edit the settings there (Copying an 
HBM sensor to the user-defined sensor database, 232).

If you configure a project channel with an HBM sensor (Configure with HBM 
sensor database, 62) without matching the sensor settings to the sensor 
data sheet, the measured values may not be accurate.

User-defined sensor database

The user-defined sensor database can contain copies of HBM sensors and 
imported CAN databases (Importing a CAN database, 245).

You can edit the user-defined sensors in the Sensor editor (Sensor 
editor, 234).

Search box

The search box enables you to search the content of the sensor database 
(Search box, 47).

A HBM sensor database, 230 D Burger menu, 231

B User-defined sensor database, 230 E Sensor group icons, 231

C Search box, 230 F Sensor icons, 231

A B C

E

F

D
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Burger menu

Sensor group icons

Sensor icons

The sensor icons represent sensor types, e.g., for a full bridge sensor.

Point to the icon to display information on the sensor type.

Command Description

Help on sensors To access context-sensitive help.

Sensor group (collapsed).

Sensor group (expanded).

Group of deleted sensors.

Group of imported sensors.
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10.3 Copying an HBM sensor to the user-defined sensor database

To use an HBM sensor, you must copy it to the user-defined sensor database 
and adjust its settings there.

To copy an HBM sensor to the user-defined sensor database

1 Click the Channels tab.

2 Click Manage.
 The Sensor manager tab is displayed.

3 On the Sensors panel, click HBM.

4 In the Sensors search box, enter the required sensor type. 

 The matching sensors are displayed.
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5 Right-click the HBM sensor you need, and then click Copy sensor to 
user database. 

 The sensor is copied to the user-defined sensor database.

 You can edit the sensor settings in the Sensor editor (Sensor 
editor, 234).
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10.4 Sensor editor

To display, click the Channels tab, and then click Manage.

To edit the settings of an HBM sensor, you must copy it to the user-defined 
sensor database and edit the settings there (Copying an HBM sensor to the 
user-defined sensor database, 232).

Apply button

Click the Apply button to save any changes.

A General tab, 236 C Apply button, 234

B Transducer settings, 237 D Burger menu, 235

A B DC
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Burger menu

Command Description

Help on sensor editor To access context-sensitive help.
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10.5 General tab

To display, click the Channels tab, click Manage, and then click General.

General information

Type the metadata of the sensor into the respective text boxes.

Attachments

You can attach a file to the sensor information, e.g., a scan of its data sheet.

 To add an attachment, click , and then double-click a file in the
Explorer.

 To delete an attachment, click the attachment, and then click .
 To display an attachment, click the attachment, and then click the

Show button.
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10.6 Transducer settings

To display, click the Channels tab, click Manage, and then click 
Transducer settings.

Transducer

Enter the sensor settings into the respective text boxes. The sensor settings 
vary with each type of sensor.

Characteristics

A characteristic is a function that calibrates the measured values. It defines 
how a valid range of electrical values, e.g., from 0 to 10 mV/V, is mapped to 
the corresponding physical values, e.g., from 0 to 50 Newton [N].

Select a scaling type (Scaling type, 238), e.g., Polynomial, and enter the 
parameters that define the characteristic, e.g., the polynomial coefficients.
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10.7 Scaling type

The scaling type determines the calibration characteristic and defines how a 
valid range of electrical values, e.g., from 0 to 10 mV/V, is mapped to the 
corresponding physical values, e.g., from 0 to 50 Newton [N].

The following scaling types are available:

 Zero span, 238
 Two-point, 239
 Table, 239
 Polynomial, 240
 Gauge, 240
 Internal, 240
 Off, 240

In the following illustrations, the x-values represent electrical values and the 
y-values represent the corresponding physical values.

Zero span

This scaling type defines a linear characteristic represented by a straight line 
through a calibration point (x0|0) and a second point defined by a span (A|B) 
added to (x0|0).

Zero span is a special case of two-point scaling (Two-point, 239).
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Two-point

This scaling type defines a linear characteristic represented by a straight line 
through two calibration points (x1|y1) and (x2|y2).

Table

This scaling type defines a linear characteristic represented by adjacent 
segments of straight lines between several calibration points (x1|y1), (x2|y2), 
(x3|y3), etc.
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Polynomial

This scaling type defines a non-linear characteristic represented by adjacent 
polynomial segments P1, P2, etc. that start in (x1|P1(x1)), (x2|P2(x2)), etc. and 
go as far as the electrical range xR.

Gauge

This scaling type is for strain gauges only and defines a linear characteristic 
by using the gauge factor, e.g., 2.1, and the bridge factor (1, 2, or 4) of the 
sensor. For the gauge factor, refer to the sensor data sheet. The bridge factor 
is determined by the number of resistors in the bridge circuit.

Internal

The calibration characteristic is defined in the data acquisition device.

Off

No characteristic is applied, i.e., the measured electrical values are taken 1:1 
as the physical values.
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11 Appendix B: CAN channels
CAN messages (Controller Area Network messages) are transmitted and 
received via a serial CAN bus system, e.g., in a car to communicate the 
status of various components, such as the engine, the brakes, and the 
airbags.

A CAN message consists of several bytes organized in a data frame with a 
message ID, control bits, and a data field. The data field contains the CAN 
signal. The encoding of a CAN signal may use one or two bits or several 
bytes.

The classic CAN protocol allows data fields with up to 8 bytes. However, the 
increasing number of sensors and control systems, e.g., in cars, demanded a 
higher bandwidth, i.e., the option to send more data in the same frame at a 
higher speed.

The CAN FD (Flexible Data Rate) protocol was developed in response to this 
need and allows to increase the bit rate during the transmission of the data 
field by a factor of up to 8. CAN FD data fields can therefore contain up to 
64 bytes and are still transmitted in the same time as the 8 bytes in classic 
CAN. The rest of the CAN message frame, however, uses the same bit rate 
as classic CAN.

If provided with a CAN database, EVIDAS can identify CAN messages, 
decode their signals, and feed their values into project channels. Each CAN 
project channel then represents one CAN signal.

To work with CAN channels, you must do the following:

 Connecting EVIDAS to a CAN bus, 242
 Defining the CAN bus settings of a connector, 243
 Importing a CAN database, 245
 Configuring CAN project channels, 247

Once you have defined the CAN bus settings and configured the CAN  
channels, you can record, visualize, and review CAN signals in the same way 
as any other signal.

However, not every data acquisition device is CAN-capable (CAN-capable 
data acquisition devices, 250).

For a list of CAN bus settings see: CAN bus settings, 251.



242 A04766_01_E00_04 

EVIDAS

11.1 Connecting EVIDAS to a CAN bus

Use this procedure to switch the first connector of a QuantumX MX840 to 
CAN bus mode.

The connectors of the other CAN-capable data acquisition devices (CAN-
capable data acquisition devices, 250) can be connected straight to a CAN 
bus.

To switch the first connector of an MX840 to CAN bus mode

1 Click the Channels tab.

2 In Devices, right-click the first channel of the MX840 module, and then 
click Change connector to CAN Bus.

 The connector is switched to CAN bus mode.

 You have 128 CAN channels available.
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11.2 Defining the CAN bus settings of a connector

You must define a separate set of CAN bus settings for each connector (CAN 
bus settings, 251).

Prerequisites

 CAN-capable data acquisition device (CAN-capable data acquisition
devices, 250).

To define the CAN bus settings of a connector

1 In Devices, right-click a CAN channel.
 The context menu is displayed.

2 Click  Edit CAN bus settings.

 The CAN bus settings dialog box is displayed.
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 If your data acquisition device, e.g., a QuantumX MX471B, has several 
CAN-capable connectors a tab for each connector is displayed.

 If your data acquisition device, e.g., a QuantumX MX471C, uses CAN 
FD, some settings must be defined for both the classic CAN as well as for 
CAN FD.

3 For each connector that is connected to a CAN bus, enter the settings used 
by the respective CAN bus (CAN bus settings, 251).
 You cannot overrule the settings of the CAN bus controller. However, 
with the Reset CAN controller button, you can reset the CAN bus 
controller.
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11.3 Importing a CAN database

A CAN database is a user-defined *.dbc file that describes how the 
CAN signals are encoded and packed into CAN messages.
You must import a CAN database into EVIDAS so that EVIDAS can decode 
the CAN signals and feed their values into project channels.

Prerequisites

 CAN-capable module is connected (CAN-capable data acquisition
devices, 250).

 EVIDAS is started.

To import a CAN database

1 Click the Channels tab.

2 Click Manage.
 The Sensor manager tab is displayed.

3 Click Import.

4 Navigate to the location of the *.dbc file, click the file, and then click Open.
 The CAN database is imported as a user-defined sensor database.
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5 Click Expand all.
 The CAN messages and their signals are displayed.

6 Click Return to Channels.
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11.4 Configuring CAN project channels

To decode the CAN signals of a CAN message, you must configure the CAN 
project channels with the signal settings from the CAN database.

Prerequisites

 CAN-capable module is connected (CAN-capable data acquisition
devices, 250).

 EVIDAS is started.
 CAN database is imported (Importing a CAN database, 245).

To configure CAN project channels

1 Click the Channels tab.

2 In Devices, click the CAN channels you need and drag them to Project 
channels.

 The selected CAN channels are now project channels.

 The CAN Bus tab in Project channels displays the default settings 
of the CAN project channels.
However, you must configure the CAN project channels with the signal 
settings from the CAN database to correctly decode the CAN signals.
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3 In Sensors, click the CAN signal you need and drag it to the respective 
CAN project channel.

 The CAN project channel is configured with the signal settings from the
CAN database.
 In the Channel name column, the CAN signal name is displayed, and 
in the Sensor / Transducer type column, indicates that the settings are 
taken from the CAN database.

4 Repeat step 3 until all CAN project channels are configured.
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5 To display the settings of a CAN signal, click the respective CAN project 
channel, and then click Configure.
 The Configure channel dialog box is displayed.

A CAN message settings B CAN signal settings

A

B
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11.5 CAN-capable data acquisition devices

To connect EVIDAS to a CAN bus, you need a data acquisition device that 
can communicate with a CAN bus.

Module Description

QuantumX MX840A
QuantumX MX840B

These modules have 8 connectors each. On each of 
the two modules you can switch the first connector to 
classic CAN bus mode (To switch the first connector of 
an MX840 to CAN bus mode, 242).
After switching to CAN bus mode, the first connector 
has 128 CAN channels.

QuantumX MX471B This module supports classic CAN and has 
4 connectors with 128 CAN channels each. You can 
connect one CAN bus to each connector.

QuantumX MX471C This module supports CAN FD and has 4 connectors 
with 128 CAN channels each. You can connect one 
CAN bus to each connector.

MGCplus ML70B/AP71
MGCplus ML71B/AP71

These modules use AP71 connection boards to 
communicate with CAN buses. Each AP71 has 
2 connectors with 128 CAN channels each.
Depending on the MGCplus housing, one or more 
AP71 connection boards can be mounted.
You can connect the CAN buses straight to the AP71 
boards, one CAN bus to each connector on the board.
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11.6 CAN bus settings

To display, click the Channels tab, right-click a CAN channel, and, on the 
context menu, click  Edit CAN bus settings.

The settings displayed depend on the data acquisiton device.

 CAN bus settings for Quantum MX840B module

 CAN bus settings for Quantum MX471C module

Most CAN bus settings are used by both, the classic CAN and CAN FD 
protocols.

The CAN FD data factor, however, exclusively applies to CAN FD. 
Depending on this factor, you also need to adjust the Sample point ratio 
in % and the Synchronization jump width.
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 Defining the CAN bus settings of a connector, 243

 CAN bus settings

CAN bus setting Description

Bit rate The speed at which the CAN bus operates. Each 
participant on the CAN bus must use the same bit rate. 
The maximum speed is 1 Mbit/s with classic CAN and 
8 Mbits/s with CAN FD (only for the data field of the 
CAN message). A slower speed allows for longer signal 
propagation time and therefore for a longer bus.

Supply voltage in V This setting is exclusively available for the Quantum 
MX840 module.
Some sensors require a supply voltage to operate. In 
general, this voltage is specified in the Configure 
channel dialog box (Configure channel dialog 
box, 76). However, for CAN channels on the Quantum 
MX840, the setting is available in the CAN bus 
settings dialog box.

Bus termination Depending on the configuration of the CAN bus, select 
this option if the data acquisition device must terminate 
the bus.

Listen-only mode The data acquisition device reads the CAN messages 
on the CAN bus, but does not send any messages.

CAN FD data factor Defines the increase of speed at which the data field of 
the CAN message is transferred by the CAN FD 
protocol.
The maximum CAN FD data factor is 8.

Sample point ratio in % The sample point ratio is the point inside the time frame 
assigned to each bit at which the signal is read and 
interpreted as a logic zero or logic one.
CAN controllers allow this point to be configured and it 
is specified as a percentage of the total bit time in 
relation to its start.
A late sample point allows for longer signal propagation 
time and therefore for a longer bus.
The sample point ratio must fit to the bit rate, the most 
common recommendation being 87.5%.
For CAN FD, you must adjust the sample point ratio 
due to the reduced bit time during the transmission of 
the data field of the CAN message. 

Synchronization jump 
width (SJW)

Noise, phase shifts, and oscillator drift create situations 
where the nominal bit rate does not equal the actual bit 
rate in the system.
The synchronization jump width adjusts the bit clock as 
necessary by 1 to 4 time quanta (TQ) to maintain 
synchronization with the transmitted message.
The length of a TQ is based on the oscillator period. 
The base TQ equals twice the oscillator period.
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12 Appendix C: Digital channels
Digital channels are binary channels, i.e., their measured values are mapped 
to either 0 or 1. To use digital channels, you need a specialized data 
acquisition device, e.g., a QuantumX MX 879B.

You can use a digital channel, e.g., to monitor the status of an electrical 
switch in order to determine when it was turned on. To know the exact time of 
an event can help you to evaluate other project channels, e.g., the voltage 
and electrical current recorded immediately after the switch is turned on.



254 A04766_01_E00_04 

EVIDAS

12.1 Digital project channels

The digital channels of a data acquisition device are displayed on the 
Devices panel. A digital channel can be in output mode  or in input 
mode .

You can drag a digital channel that is in input mode  to the Project 
channels panel. EVIDAS does not support digital channels that are in output 
mode  as project channels. If you want to use a digital channel that is in 
output mode  as project channel, you must first switch it to input mode
(Switching digital channel to input mode, 256).

Digital channel icons

A Digital channel icons, 254 B Digital channel LEDs, 255

A B

Digital channel in input mode.

Digital channel in output mode.

Digital project channel.
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Digital channel LEDs

You can do the following with digital project channels:

 Define an online calculations channel using a digital project channel as
input channel in a formula (Online calculations, 111).

 Visualize a digital project channel in a y(t) chart, on a digital meter, or in a
data table (Visualization, 145).

 Record the measured values in a data file (Acquisition, 125).
 Review the measured values (Data manager, 201).

Digital project channels do not need sensor settings or a filter. The electrical 
value ranges that are mapped to either 0 or 1 are defined in the specialized 
data acquisition device.

However, you can select a sample rate for a digital project channel.

If you have a digital channel on the Project channels panel and, on the 
Devices panel, you switch the digital channel from input mode  to output 
mode , the channel is removed from the Project channels panel.

Measured value = 0.

Measured value = 1.
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12.2 Switching digital channel to input mode

If you want to use a digital channel as project channel and the connector is in 
output mode , you must first switch the connector to input mode .

Prerequisites

 Data acquisition device with digital channels is connected.
 EVIDAS is started.

 The digital channel you want to use is in output mode .

To switch a digital channel to input mode

1 Click the Channels tab.

2 In Devices, right-click the digital channel that is in output mode , and 
then click Change connector to digital input.

 The digital channel is switched to input mode .

 A digital channel must be in input mode  before you can use it as 
project channel.
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13 Appendix D: FFT Introduction
The fast Fourier transform (FFT) is a specific form of the discrete Fourier 
transform (DFT) using 2n measured values as a data block to compute the 
frequency components of a signal in real time. Mathematically, this is possible 
because any periodic function y(t) can be decomposed into a weighted sum 
of sines and cosines, i.e., y(t) can be represented as a spectrum of 
frequencies f(ω).

13.1 FFT charts

An FFT chart visualizes the frequencies that together form a signal by 
displaying amplitude over frequency.

 A 35 Hz sine and a 10 Hz triangular waveform in a y(t) chart to the left, and an 
FFT chart with the same signals to the right. In the FFT chart, the frequency 
components that contribute to the respective waveforms become apparent.

Frequency analysis is used to analyze periodic as well as transient signals. It 
is applied in acoustics, communications, geology, modal testing, and many 
more application areas. It allows you to analyze the content of mixed signals 
such as vibrations, shocks, or noisy signals beyond what is visible in the time 
domain display (Time domain versus frequency domain, 258).

Example: If a speaker hisses or buzzes, an analysis of the frequency 
spectrum can show which frequency is causing the unwanted noise, e.g., a 
50 Hz / 60 Hz signal from the power supply.

 Visualizing the frequency spectrum of a signal in an FFT chart, 186
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13.2 Time domain versus frequency domain

An FFT calculation transfers blocks of data from the time domain to the 
frequency domain.

Time domain

In the time domain you observe and analyze how a signal changes over time. 

You define measurement settings such as the sample rate and filters to 
eliminate noise (Channels tab, 74). You are interested in individual 
measured values, e.g., to determine the resistance of a component to stress 
and strain.

Frequency domain

Looking at the same signal in the frequency domain reveals how the signal's 
energy is distributed over a range of frequencies.

In the frequency domain, you are not concerned about individual measured 
values. You must decide about a whole different set of settings that influence 
the accuracy and performance of the FFT calculation, such as the block size, 
frequency resolution, or number of lines (Block settings, 259).

Some of those settings depend on each other (Dependencies between block 
settings, 262).

In order to minimize the effects of spectral leakage (Spectral leakage, 264), 
you must select a window function to reduce the discontinuities at the edges 
of the data block (Windowing, 264).

In order to control the noise in the signal and to find its stationary frequencies, 
you can use an averaging option (Averaging, 267).

The frequency spectrum displayed on the FFT chart is not stored. However, it 
can be recalculated from the measured values in the review file.
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13.3 Block settings

The FFT is applied to 2n measured values, i.e., a limited block of data. 
Therefore, the block size and related settings (Definitions of block 
settings, 259) determine the accuracy and performance of the 
FFT calculation.

The block settings are defined on the FFT settings tab (FFT settings 
tab, 167).

13.3.1 Definitions of block settings

Sample rate fs
The sample rate fs is the number of measured values acquired per 
second [S/s]. Its unit is Hertz [Hz] = [1/s].

The sample rate used in the frequency domain is the same as in the time 
domain.

Sample period Δt

The sample period Δt is the increment in time during which one measured 
value is acquired. Its unit is seconds [s]. It is related to the sample rate fs.

Example: If the measured values are acquired at a sample rate of 
fs = 9600 Hz, the sample period Δt is

Block size N

The block size N is the number of measured values needed for an 
FFT calculation and must be 2n with n ≥ 8, i.e., 256, 512, 1024, 2048, 4096, 
8192, 16384, etc.

The FFT calculation takes one block of measured values at a time to 
calculate the frequency spectrum of the signal, e.g., a set of 2048 measured 
values. Once the frequency spectrum is calculated and displayed, the FFT 
waits until the next block is acquired, i.e., the next 2048 measured values. As 
soon as those values are available, the next frequency spectrum is calculated 
and displayed.

Sample blocks can be overlapped and frequency spectrums can be averaged 
to reduce noise (Averaging, 267).

The larger the block size, the longer the FFT calculation will take and the 
more accurate the frequency spectrum will be.

Δt 1
fs
----=

Δt 1
9600
------------- s=
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In EVIDAS, if you select a block size N, both the frequency resolution Δf and 
the number of lines L will be adjusted accordingly (Dependencies between 
block settings, 262).

Block duration T

The block duration T is the total acquisition time needed to record the 
measured values of one block, i.e., the time needed to record N measured 
values where N is the block size. The unit of the block duration is seconds [s].

The time to record a block depends on the block size N and the sample 
period Δt.

Example: The time to record a block with N = 2048 measured values at a 
sample rate of fs = 9600 Hz is

Frequency resolution Δf

The frequency resolution Δf is a measure for the accuracy of the FFT output 
and defines the width of one frequency bin on the x-axis.

It is determined by the block duration T.

For example, if the block duration T = 1 s, the frequency resolution Δf = 1 Hz. 
If the block duration T = 2 s, the frequency resolution Δf = 0.5 Hz.

Therefore, the longer the block duration T, i.e., the larger the block size N 
(assuming that the sample rate fs is fixed), the more information is available 
for the FFT calculation and the smaller, i.e., better, the resulting frequency 
resolution Δf will be.

It follows that,

In EVIDAS, if you select a frequency resolution Δf, both the number of lines L 
and the block size N will be adjusted accordingly (Dependencies between 
block settings, 262).

Example: The frequency resolution Δf for the above block duration 
T = 0.21333 s is

T N Δt⋅=

T N Δt⋅ N 1
fs
----⋅ 2048 1

9600 Hz
----------------------⋅ 0.21333 s= = = =

Δf 1
T
---=

Δf 1
T
--- 1

N Δt⋅
--------------= =

Δf 1
T
--- 4.6875 Hz= =
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Frequency span F

According to the Nyquist-Shannon sampling theorem, if a function y(t) 
contains no frequencies higher than B Hertz, it is completely determined by 
giving its ordinates at a series of points spaced 1/(2 · B) seconds apart.

Therefore, if F is the maximum frequency of a band-limited signal, the sample 
period Δt must be 1/(2 · F) seconds apart to completely determine the signal.

This leads to

The frequency span F defines up to which frequency the FFT will produce a 
result.

Example: If the measured values are acquired at a sample rate fs = 9600 Hz, 
the frequency span F is

Number of lines L

The number of lines L is defined as the ratio of the total frequency span F in 
relation to the frequency resolution Δf.

The better the frequency resolution Δf, i.e. the smaller Δf, the larger the 
number of lines, i.e., the information content of the frequency spectrum.

In EVIDAS, if you select a number of lines L, both the block size N and the 
frequency resolution Δf will be adjusted accordingly (Dependencies between 
block settings, 262).

Example: For the above frequency span F = 4800 Hz and frequency 
resolution Δf = 4.6875 Hz, it follows that

 FFT settings tab, 167

Δt 1
2 F⋅
-----------=

F 1
2 Δt⋅
------------- 0.5 fs⋅= =

F 0.5 fs⋅ 4800 Hz= =

L F
Δf
-----=

L F
Δf
----- 4800 Hz

4.6875 Hz
--------------------------- 1024= = =
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13.3.2 Dependencies between block settings

Several of the FFT frequency settings are dependent on each other.

Sample rate fs and frequency span F

The frequency span F is determined by the sample rate fs.

Example: If the measured values are acquired at a sample rate fs = 9600 Hz, 
the frequency span is F = 4800 Hz. No frequencies higher than 4800 Hz will 
be displayed on the FFT chart.

Block duration T and block size N

With the sample rate fs fixed, the block duration T is determined by the block 
size N.

With 

it follows that 

Example: The time to record a block with N = 2048 measured values at a 
sample rate of fs = 9600 Hz is

F 0.5 fs⋅=

T N Δt⋅=

Δt 1
fs
----=

T N
fs
----=

T N
fs
---- 2048

9600 Hz
---------------------- 0.21333 s= = =
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Frequency resolution Δf, number of lines L, and block size N

If the sample rate fs is fixed, and either the frequency resolution Δf, or the 
number of lines L, or the block size N is given, the other two settings are 
determined.

To verify this, let us say the block size N is given. The frequency resolution Δf 
is then determined by

Now, if the frequency resolution Δf is thus determined, the number of lines L 
is derived as follows

And if the number of lines L is determined, then again the block size N can be 
derived as

Example: If the measured values are acquired at a sample rate of 
fs = 9600 Hz, and the block size is N = 2048, the frequency resolution is

Then it follows that the number of lines is

And thus the block size is again

 FFT settings tab, 167

Δf 1
N Δt⋅
--------------

fs
N
----= =

L F
Δf
-----

0.5 fs⋅
Δf

-----------------= =

N
fs
Δf
----- fs

L
0.5 fs⋅
-----------------⋅ 2 L⋅= = =

Δf
fs
N
---- 9600 Hz

2048
---------------------- 4.6875 Hz= = =

L
0.5 fs⋅

Δf
----------------- 4800 Hz

4.6875 Hz
--------------------------- 1024= = =

N 2 L⋅ 2048= =
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13.4 Windowing

Windowing weighs the measured values of a sample block prior to the 
FFT calculation in order to reduce the discontinuities at the edges of the 
sample block and thus to improve the accuracy of the frequency spectrum 
obtained by the FFT calculation.

Spectral leakage

The FFT calculation assumes that the measured values recorded during the 
block duration T represent just one period of an infinitely repeating periodic 
signal.

However, in practical applications the block usually contains an incomplete 
number of cycles, which leads to discontinuities at the edges of the sample 
block, i.e., when placing one block next to a copy of it, the last measured 
value of the block does not correspond to the first measured value of the next 
(copied) block.

In the FFT, these discontinuities show up as frequency components not 
present in the original signal, i.e., the frequency spectrum calculated by the 
FFT does not represent the spectrum of the original signal, but a smeared 
version of it. It appears as if energy from one frequency leaks into other 
frequencies. The phenomenon is therefore known as spectral leakage.

 Due to discontinuities at the edges of the sample block, a sine signal is not represented as a single sharp peak, but smeared 
across neighboring frequency bins.

An FFT calculation analyzes only a short slice of the signal and therefore 
outputs the frequency spectrum of a theoretical signal, that is composed of 
infinite repetitions of that slice of 2n measured values.
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Window functions

Window functions are used to reduce the amplitude of the discontinuities at 
the edges of the sample block. The measured values of the signal are 
multiplied with the window function whose amplitude tapers towards zero at 
the edges.

The width of the window must match the block duration T, i.e., the window 
function operates on all measured values within a block.

The result is a windowed signal with very small or no discontinuities and 
therefore reduced spectral leakage.

You can choose from among different types of window functions to reduce 
spectral leakage.

Each window function is designed to optimize the FFT output for a specific 
signal type.

If you do not know which signal to expect, the Hann(ing) window is a good 
starting point and is sufficient in 95% of all cases.

Window function Description Best for signal type

Rectangular This is the window function with the highest 
amount of spectral leakage. It has a value of 1 
over the whole block duration and is equivalent 
to no window at all.

Transient signals that have a duration shorter 
than the block duration.

Hann(ing) Bell-shaped curve. Transient signals that have a duration longer 
than the block duration.
General-purpose window function.

Hamming Modified version of the Hann(ing) window. Transient signals that have a duration longer 
than the block duration.
General-purpose window function.

Blackman Provides a high rejection of signals outside its 
main lobe.

Single tone measurements.

Blackman-Harris Modified version of the Blackman window. Single tone measurements.
Flattop This window function has the best amplitude 

accuracy, but a poor frequency resolution.
Use this window when amplitude accuracy is 
important. However, it cannot be used to detect 
nearby frequency components.
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If a window function is applied, it reduces the amplitude of the time domain 
signal, especially at the edges of the sample block. The resulting loss in 
signal power is called coherent gain (Comparison of window 
functions, 266).

The FFT output must be corrected to compensate for this loss of signal 
power.

Comparison of window functions

When selecting a window function, consult the following table for their 
respective features.

 FFT settings tab, 167

Window function

Highest 
Side-Lobe 
Level
[dB]

Side-Lobe 
Roll-Off-
Rate 
[db/Oct]

Coherent 
Gain

Normalized 
Equivalent 
Noise 
Bandwidth 
[bins]

-3 dB
Bandwidth
[bins]

-6 dB
Bandwidth
[bins]

Max. 
Amplitude 
Error
[dB]

Rectangular -13 -6 1.00 1.00 0.8845 1.21 -3.92
Hann(ing) -31 -18 0.50 1.50 1.4382 2.00 -1.42
Hamming -43 -6 0.54 1.36 1.3008 1.81 -1.75
Blackman -58 -18 0.42 1.73 1.6800 2.35 -1.10
Blackman-Harris -92 -6 0.36 2.00 1.8962 2.72 -0.83
Flattop -93 -6 0.22 3.77 3.7200 4.58 < -0.02
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13.5 Averaging

Averaging is used to control the noise in the signal in order to identify the 
stationary frequencies that are otherwise hidden in the noise band. As noise 
is considered to be a random component of the signal and hence having a 
zero mean, it can almost fully be eliminated by averaging.

EVIDAS offers the following averaging options:

 FFT settings tab, 167

Averaging option Description

Exponential averaging Exponential averaging uses all frequency spectrums 
calculated within a time period you define and averages 
the amplitudes per frequency across those spectrums, 
whereby more recent frequency spectrums are taken 
into account more prominently than older ones.
After the time period you define, e.g., 10 seconds, the 
influence of historical data on the average drops 
below 1%.
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13.6 Frequency analysis options

You can choose between the following frequency analysis options:

Analysis option Description Unit of y-axis

FFT Spectrum (peak) Displays amplitude over frequency, i.e., the frequency 
distribution of the signal.
The FFT Amplitude Spectrum AS [Vpeak] is determined 
by

The FFT output is thus normalized by the block size N, 
and the loss of energy caused by windowing is 
compensated with the CoherentGain factor of the 
respective window function (Comparison of window 
functions, 266).

[Vpeak]

Linear Spectrum (RMS) Displays RMS over frequency.
The linear spectrum AS [Vrms] is determined by

The factor  is only applied for non-DC components.

[Vrms]

Power Spectrum (PS) Displays the energy of a signal over frequency.
The power spectrum PS is determined by

for use with already compensated windowed data.

[V2] = [W]

Power Spectral Density (PSD) Displays the strength of the variations in energy over 
frequency, i.e., at which frequencies variations are 
strong and at which frequencies variations are weak.
The Power Spectral Density PSD is determined by

where NENBW is the normalized equivalent noise 
bandwidth of the respective window function 
(Comparison of window functions, 266) and Δf is the 
frequency resolution of the FFT.

[V2/Hz] = [dBm/Hz]

AS Vpeak[ ] 1
CoherentGain
----------------------------------------- FFT

N
--------------⋅=

AS Vrms[ ] 1
2

------- AS Vpeak[ ]⋅=

1
2

-------

PS 2 AS2⋅=

PSD PS
NENBW Δf⋅
---------------------------------=
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Use the following table to find the analysis option that fits your application.

 FFT settings tab, 167

Signal type Your application You can use

Transient Depending on requirements and window. Power Spectral Density (PSD)
Depending on requirements and window. Power Spectrum

Periodic Observe the spectrum of the signal. FFT Spectrum
Observe the spectrum of the signal. Linear Spectrum (RMS)
Observe the power of the signal. Power Spectrum

Random Observe the power of the signal. Power Spectrum
Normalized measurement of the power per unit 
bandwidth.

Power Spectral Density (PSD)
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Index
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Above level trigger mode,  131
Acquisition,  125
Acquisition control panel,  41
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Activating EVIDAS,  12
Activation key,  11
Algebra calculation panel,  116
Algebra keyboard,  116
Aliasing,  99
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Assistance,  222
Auto Hide,  50
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- FFT chart,  164
- signal preview,  78
- X-Y chart,  159
- y(t) chart,  154
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B
Balancing,  101
Below level trigger mode,  131
Bessel filter,  97
BIN format,  210
Binary channel,  253
Blackman window,  265
Blackman-Harris window,  265
Block duration,  260
Block settings
- block duration,  260
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- dependencies,  262
- display for all project channels,  168
- frequency resolution,  260
- frequency span,  261
- number of lines,  261
- sample period,  259
- sample rate,  259

Block size,  259
Books on strain gauges,  271
Boolean operators (online help),  32
Bridge factor,  240
Butterworth filter,  97

C
Calculation channel
- define algebra channel,  122
- define rosette calculations,  123
- delete,  112
- display,  113

Calculation panel
- algebra panel,  116
- header,  115
- rosette panel,  118

Calibration
- characteristic,  237
- linear,  238
- non-linear,  240
- parameters,  81

CAN bus settings
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- define,  243
- sample point ratio,  251
- supply voltage,  251
- synchronization jump width,  251

CAN channel
- configure,  247

CAN database
- import,  245

CAN message
- data field,  241
- frame,  241
- signal settings,  247

CAN-capable devices,  250
Channel
- add comment,  108
- assign filter automatically,  100
- assign sample rate automatically,  100
- configure CAN channel,  241
- configure in dialog box,  64
- configure on panel,  67
- configure with database,  62
- configure with TEDS sensor,  61
- switch digital channel to input mode,  256
- visualize,  25

Channels,  73
Characteristic,  237
Classic sample rate domain,  90
Cloud
- access via web browser,  208
- activate,  23
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- define storage location,  23
- download data file,  203
- storage capacity,  208
- upload data file manually,  203
- upload data files automatically,  138

Coherent gain,  266
Command group,  39
Comment
- channel,  108

Configure channel dialog,  76
Contextual tab
- for data table,  171
- for digital meter,  169
- for FFT chart,  161
- for text box,  173
- for visualization panel,  175
- for X-Y chart,  156
- for y(t) chart,  151

Coordinate system
- add,  179
- define dual,  179
- define layered,  179
- define number of y-axes,  179
- define stacked,  179

Correction polynomial,  87

D
Data acquisition device
- add,  104
- blink module LEDs,  104
- CAN-capable,  250
- change IP address,  104
- define CAN bus settings,  243
- internal scaling,  240
- load automatically at program start,  224
- switch digital channel to input mode,  256
- switch to analog input,  104
- switch to CAN,  242

Data file
- copy,  208
- rename,  208

Data file settings
- default folder,  136
- file format,  139
- filename,  136
- metadata,  140
- placeholders,  136
- storage options,  138
- upload to HBM cloud,  138

Data manager,  201
Data sheet,  87

Data streaming to IoT
- select channels,  144
- setup,  142
- specify endpoint,  143

Data table,  171
Database
- copy HBM sensor,  232
- import CAN database,  245
- import user-defined database,  228

Decimal sample rate domain,  90
Default folder
- data files,  136
- project files,  220

Device
- add,  104
- blink module LEDs,  104
- CAN-capable,  250
- change IP address,  104
- define CAN bus settings,  243
- internal scaling,  240
- load automatically at program start,  224
- switch digital channel to input mode,  256
- switch to analog input,  104
- switch to CAN,  242

Device lost behavior,  134
Devices panel,  104
Dialog Box Launcher,  39
Digital channel,  253
Digital meter,  169
Docking,  51

E
Editor
- formula,  116
- sensor,  234

Event logging,  224
EVIDAS
- activate manually,  15
- activate online,  13
- install,  11
- register for network license,  19
- renew license,  34
- upgrade to full version,  222
- use as trial version,  21
- use as viewer,  22

EVIDAS data file format,  210
EVIDAS project file format,  57
Exit,  220
Export channels
- merge,  216
- select,  211

Export format,  203
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F
Factory settings
- reset data acquisition device,  104
- reset EVIDAS,  224

Falling edge trigger mode,  131
Fast Fourier transform,  257
Favorite folders,  206
FFT chart
- assign project channel,  186
- define background color,  162
- define color of trace,  166
- define exponential averaging,  167
- define FFT calculation settings,  167
- define horizontal grid lines,  164
- define line style,  166
- define logarithmic scaling,  164
- define output spectrum,  167
- define scaling of y-axis,  164
- define unit of y-axis,  164
- define vertical grid lines,  164
- define window function,  167
- define y-axis dual,  162
- define y-axis layered,  162
- define y-axis stacked,  162
- delete trace,  166
- display peak markers,  162
- edit chart title,  162
- edit title of y-axis,  164
- format chart title,  162
- hide legend,  162
- insert,  186

FFT settings
- block settings,  259
- exponential averaging,  267
- frequency analysis options,  268
- window functions,  264

File browser,  205
File formats,  139
File list
- filter by extension,  206
- filter by filename,  206

File menu,  219
Filter
- anti-aliasing,  97
- Bessel,  97
- Butterworth,  97
- bypass,  97
- configure automatically,  100
- threshold,  98

Firmware
- update,  104

Flattop window,  265
Floating license
- borrow,  37
- return borrowed,  37

Floating panel,  51
Freeze,  40
Frequency analysis,  257
Frequency domain,  258
Frequency resolution,  260
Frequency span,  261
Full screen button,  178

G
Gauge factor,  84
Gauge scaling,  240
Group,  39

H
Hamming window,  265
Hann(ing) window,  265
Hardware mapper,  72
HBM cloud
- access via web browser,  208
- activate,  23
- define storage location,  23
- download data file,  203
- storage capacity,  208
- upload data file manually,  203
- upload data files automatically,  138

HBM sensors,  230
Help on EVIDAS,  27
H-zoom,  146

I
In use bar,  80
Input channel,  116
Input mode,  254
In-Ribbon Gallery,  39
Installing EVIDAS,  11
IoT platform,  141

K
k-factor,  84
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L
Lead wires,  84
LED
- blink channel LED,  108
- blink module LEDs,  104

Legend
- in FFT chart,  162
- in X-Y chart,  157
- in y(t) chart,  152

License
- activate manually,  15
- activate online,  13
- borrow,  37
- register for network license,  19
- renew manually,  36
- renew online,  35
- return borrowed,  37

License information,  222
License manager,  222
License server,  19
License type
- network,  222
- single,  222

Line style
- in FFT chart,  166
- in X-Y chart,  160
- in y(t) chart,  155

Linear spectrum (RMS),  268
Lissajous curve,  156
Live mode,  146
Live signal
- compare with review channel,  212

Logarithmic scaling
- FFT chart,  164
- X-Y chart,  159

Low-pass filter,  98

M
Machine ID,  15
Material properties,  118
Maximum value,  172
Mean value,  172
Measuring range,  80
Metadata,  140
Minimum value,  172
Modal tab,  44
Monitoring
- select channels,  144
- setup,  142
- specify endpoint,  143

Multi-point reading,  103

N
Name prefix,  118
Network license,  12
Noise,  98
Normalized equivalent noise bandwidth,  266
Notation of measured value
- in data table,  172
- in digital meter,  170
- in project channels list,  108

Notifications,  42
Number of lines,  261
Numeric display,  169
Nyquist-Shannon,  99

O
Online calculations,  111
Online help
- Boolean operators,  32
- search,  32
- via burger menu,  29
- via context menu,  31
- via F1,  28
- via tooltip,  30

Output mode,  254
Overflow replacement,  224
Overview mode,  146

P
Panel
- Auto Hide,  50
- docking,  51
- floating,  51
- tabbed,  51
- vertical tab,  50

Panel elements,  45
Peak markers,  162
PNRF format,  139
Polynomial coefficients,  84
Polynomial scaling,  240
Post-trigger time,  129
Power spectral density (PSD),  268
Power spectrum,  268
Pre-trigger time,  129
Print
- visualization object,  146

Program
- exit,  220
- options,  224
- start,  24
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Project
- configure channels,  60
- open,  71
- open automatically at program start,  224
- open even if device not found,  72
- save,  70
- select channels,  59
- set up,  57
- start new,  58

Project channel
- assign filter automatically,  100
- assign sample rate automatically,  100
- configure CAN channel,  241
- configure in dialog box,  64
- configure on panel,  67
- configure with database,  62
- configure with TEDS sensor,  61
- select,  59

Project channels panel,  107
Project data folder,  206
Project file format,  57
Project files
- default folder,  220

Push URL,  143

Q
Quarter bridge
- data sheet,  87
- temperature correction options,  82
- temperature correction parameters,  84

R
Recording options
- default folder,  136
- device lost behavior,  134
- file format,  139
- filename,  136
- metadata,  140
- placeholders,  136
- repeat recording,  133
- start options,  127
- stop options,  128
- storage options,  138
- trigger modes,  131
- trigger options,  129
- upload to HBM cloud,  138
- zero balance before recording,  133

Rectangular window,  265
Reference temperature,  84
Release number,  222

Reset
- data acquisition device,  104
- EVIDAS,  224

Review channel
- compare with live signal,  212
- select,  210
- visualize,  210

Ribbon
- minimize,  39

Ribbon elements
- commands,  39
- contextual tabs,  43
- Dialog Box Launcher,  39
- groups,  39
- In-Ribbon Gallery,  39
- modal tabs,  44
- tabs,  39

Rising edge trigger mode,  131
Rosette
- assign source channels,  118
- material properties,  118
- name prefix,  118
- transverse sensitivity correction,  118

Rosette calculation panel,  118
R-zoom,  146

S
Sample period,  259
Sample point ratio,  251
Sample rate
- assign to project channel,  93
- change,  93
- configure automatically,  100

Sample rate domain
- change,  92
- classic,  90
- decimal,  90

Sample rate groups,  91
Scaling
- gauge,  240
- internal,  240
- polynomial,  240
- table,  239
- two-point,  239
- zero span,  238

Scaling type,  238
Search box,  47
Search in online help,  32
Segmented scaling
- linear,  239
- non-linear,  240
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Sensor
- add,  228
- attach data sheet,  236
- define characteristic,  237
- define metadata,  236
- define settings,  237
- duplicate,  228
- search,  62

Sensor data sheet,  87
Sensor database
- copy HBM sensor,  232
- import CAN database,  245
- import user-defined database,  228

Sensor editor,  234
Sensor group,  228
Sensor manager,  227
Sensor metadata,  236
Sensor settings
- attach data sheet,  236
- define,  237
- define characteristic,  237
- define metadata,  236

Sensor types
- strain gauge,  82
- TEDS,  88

Sensors panel,  230
Signal
- display in live mode,  146
- display in overview mode,  146

Signal preview,  78
Single license,  12
Single-point reading,  103
Snap grid,  175
Spectral leakage,  264
Standard deviation,  172
Start recording,  127
Status panel,  41
Stop recording,  128
Strain gauge
- books,  271
- data sheet,  87
- temperature correction options,  82
- temperature correction parameters,  84

Streaming dataset,  141
Synchronization jump width,  251

T
Tab
- contextual,  43
- modal,  44

Tabbed panel,  51
Table,  171
TEDS sensor
- activate,  88
- configure project channel,  61
- ignore,  88

Temperature channel,  82
Temperature coefficient of gauge factor,  84
Temperature correction options,  82
Temperature correction parameters,  84
Text box,  173
Thermal expansion coefficient,  84
Time count,  41
Time domain,  258
Time increment,  152
Time line,  134
Time of minimum / maximum,  172
Time unit,  152
Time window for live mode,  152
Trace
- define line style,  196
- delete,  192
- display in live mode,  146
- display in overview mode,  146
- scroll,  194
- zoom,  193

Traceability data,  207
Transverse sensitivity correction,  118
Tree-view,  49
Trial version,  21
Trigger level,  129
Trigger mode,  131
Trigger options,  129
Two-point scaling,  239

U
Update rate
- for digital meter,  170
- for monitoring,  142
- for overview mode,  152

User interface language,  224
User-defined sensors,  230
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V
Vertical tab,  50
Viewer,  22
Visualization,  145
- examples,  179
- freeze,  40

Visualization object
- change size,  189
- copy,  189
- insert,  146
- move,  189
- print,  146
- work on several at the same time,  198
- zoom,  146

Visualization panel
- add,  146
- define name,  175
- define snap grid,  175
- full screen button,  177
- maximize,  146

Visualization panel tab,  177

W
Window functions,  265
Windowing,  264

X
X-Y chart
- assign project channels,  182
- assign Y-channel to y-axis,  160
- define background color,  157
- define color of trace,  160
- define grid lines,  157
- define line style,  160
- define logarithmic scaling for y-axis,  159
- define number of y-axes,  157
- define scaling of y-axis,  159
- define time window,  157
- define y-axis dual,  157
- delete trace,  160
- edit chart title,  157
- edit title of y-axis,  159
- format chart title,  157
- hide legend,  157
- insert,  182

Y
y(t) chart
- add chart title,  152
- assign project channel,  179
- define background color,  152
- define color of trace,  155
- define horizontal grid lines,  154
- define line style,  155
- define scaling of y-axis,  154
- define time unit,  152
- define time window for live mode,  152
- define y-axis dual,  152
- define y-axis layered,  152
- define y-axis stacked,  152
- delete trace,  155
- display in live mode,  146
- display in overview mode,  146
- edit title of y-axis,  154
- format chart title,  152
- hide legend,  152
- insert,  179
- zoom,  146

Z
Zero balancing,  101
Zero balancing before recording,  133
Zero span scaling,  238
Zero value
- define calculation,  103

Zoom
- trace,  146
- visualization object,  146
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